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What's New

Below you find:
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• What’s New in the Object Libraries
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The Objects Reference Help

The SimTalk Reference Help

The Outdated SimTalk Names in 2D

The 3D Reference Help

The SimTalk Access to 3D

The Outdated SimTalk Names in 3D

The Add-Ins Reference Help

The Object Libraries Reference Help

Copyright © 2020 Siemens Industry Software Inc. All rights reserved.

, Plant Simulation 16.0  1-1
© 2020 Siemens



This documentation is proprietary to Siemens Industry Software Inc.

This document contains proprietary information and is protected by copyright. No part of this document
may be reproduced, stored in a retrieval system, translated, transcribed, or transmitted, in any form or
by any means, without the prior explicit written consent of Siemens Industry Software Inc.

Information in this document is subject to change without notice.

What's New in Tecnomatix Plant Simulation 16

What's New in Tecnomatix Plant Simulation 16

Tecnomatix Plant Simulation 16 provides a number of new and improved features.

• Important Changes in Plant Simulation

• Simulation- and Animation-Relevant Changes

• New Features of the Material Flow Objects

• Changed Features of the Material Flow Objects

• New and Changed Features of the Fluid Objects

• New and Changed Features of the Resource Objects

• New and Changed Features of the Information Flow Objects

• New and Changed Features of the User Interface Objects

• New 3D Features

• Changed 3D Features

• New and Changed SimTalk Features

• Miscellany

• New and Changed Features in the Object Libraries
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Note:

As opposed to the full versions, for example Tecnomatix Plant Simulation 16.0, we only support
English and German as the user interface language for the intermediate versions, for example for
Tecnomatix Plant Simulation 16.1.

Back to What’s New

Important Changes in Plant Simulation

We made important changes in Tecnomatix Plant Simulation 16.0. For this reason you have to adapt
simulation models which you created in previous versions of Tecnomatix Plant Simulation, when you
open them in Tecnomatix Plant Simulation 16.

Important Changes in Plant Simulation 15.1

We restricted the support for SimTalk Version 1.0 in the Method Editor.

• We deactivated syntax-controlled indentation and formatting of the source code for SimTalk
Version 1.0.

• We removed color highlighting of keywords, which only exist in SimTalk 1.0, and outlining of
structures specific to SimTalk Version 1.0.

• We removed inserting of structures specific to SimTalk Version 1.0 via templates.

Back to What’s New in Tecnomatix Plant Simulation 16

Simulation and Animation Relevant Changes

We made changes that are relevant for the simulation and the animation in Tecnomatix Plant
Simulation 16.0 For this reason you have to adapt simulation models, which you created in previous
versions of Tecnomatix Plant Simulation, when you open them in Tecnomatix Plant Simulation 16.0.

Simulation- and Animation-Relevant Changes in Plant Simulation 16.0

• We changed what Plant Simulation does when an object changes to the Unplanned state.

• In previous versions the Unplanned control as well as the Pause control were called.

• From version 16 on only the Unplanned control is called. For compatibility reasons Plant
Simulation still sets the attribute Pause to true when Unplanned is set to true.

• We changed how Plant Simulation enters Pause and Shift events into the list of simultaneous events.

Important Changes in Plant Simulation
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• In previous versions the Out event of a completely processed MU was sometimes only scheduled
after the end of the shift, even if it occurred simultaneously with the shift end, and the MU
remained on the station until the new shift started.

• From version 16 on Pause and Shift end events are always entered into the list of simultaneous
events as the last events.

• We enhanced the behavior of an empty workpiece carrier.

• In previous versions an empty workpiece carrier was always moved on to the default successor.

• For the following settings of the designated objects Plant Simulation uses the attributes or the
name of the empty workpiece carrier.

■ For the setting Exit > Strategy > MU Attribute of the material flow objects.

■ For the settings Exit behavior > Strategy > MU Attribute and MU Name of the FlowControl.

■ For the settings Attributes > Assembly table > MU Types and Depends on Main MU of the
AssemblyStation.

■ For the settings Attributes > Strategy > MU Attribute and MU Name of the Turnplate.

■ For the settings Attributes > Strategy > MU Attribute and MU Name of the Converter.

■ For the setting Fluid depends on > MU Name of the DePortioner.

• We changed how Plant Simulation handles the bounding box of parts that a Worker carries. From this
version on the bounding box of the parts does not affect the computation of the bounding box of the
Worker who carries parts. This is simulation-relevant if you used the bounding box in a model from
previous versions to set simulation-relevant attributes, for example MUHeightWithContent.

• We changed the behavior of Plant Simulation. In previous versions you could read the attributes
ProcTime and SetupTime for some objects that do not have a processing time or setup time. This
caused the method hasAttribute to return true for these attributes. This is no longer the case.

• We replaced the tag eMPlantTable when exporting DataTables in XML format with the tag
PlantSimulationTable, compare Export XML File. Plant Simulation can still read XML files that were
written with the old tag by previous versions, but not the other way around. In addition the written
XML file does not use a namespace any more.

Simulation- and Animation-Relevant Changes in Plant Simulation 15.2

• We changed the behavior of the PickAndPlace Robot. If the robot is to load parts onto a Container or
a Transporter at the sensor, it now only picks the part up when a Container or a Transporter waits at
the sensor.

1. What's New
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• We changed the behavior when setting-up a material flow object. If the value 0 was determined in
previous versions when setting the set-up time, for example resulting from a distribution or from a
formula, Plant Simulation treated this as if a setup process had taken place, without requesting
Workers though. When setting up after n parts this setup process was not counted though. From
this version on the counter is reset for a setup process of time 0.

• We changed the conversion of the speed units mph (miles per hour) and m/s (meters per second)
under Preferences > Units > Speed and Model Settings > Units > Speed:

Up to and including Plant Simulation 15.1 1 mph = 0.444444 m/s or 1m/s = 2.25 mph

From Plant Simulation 15.2 on 1 mph = 0.44704 m/s or 1m/s = 2.236936 mph

Simulation- and Animation-Relevant Changes in Plant Simulation 15.1

• We changed the behavior when deleting MUs. Plant Simulation now calls the sensor control of a
sensor triggered by a light barrier (Light barrier mode). The sensor control will not be called when
MUs are deleted when resetting the model with Reset.

• We enhanced the behavior of the methods create and insert of the moving objects: You can now also
create or insert an MU at the beginning of a length-oriented object if a part of the MU hangs in thin
air afterwards, i. e., is not located all the way on the length-oriented object.

• We changed the behavior of the method getRouteLength of the MUs. It returned the value -1 up to
and including version 14.1. From version 14.2 on the method returned the value
1.79769313486232e+308. In this version the method returns -1 again.

• We implemented an optimization for accessing the index in DataTables in Plant Simulation 14.1. This
optimization caused unexpected behavior if the index had the data type string:
If the DataTable contained strings in the index which only used different upper and lower casing,
Plant Simulation found the index, if it existed, whose casing of the string matched the notation of the
string with which the index was accessed. If it did not exist, the index was returned, which matched
the value without considering case sensitivity.
This behavior only occurred when the setting Fast index access was activated.
From this version on Plant Simulation finds the first index entry again which is identical while
ignoring case sensitivity, no matter if Fast index access is activated or not.

• We removed the text box Curve precision from the tab 3D in the dialog Preferences. For this reason
we do not support the attribute _3D.CurvePrecision any longer.
To control curve sampling of polycurves and splines, we now use a common dynamic mechanism
which is independent of the curve radius.
This change can alter simulation results in models with length-oriented objects with curve segments,
if a Worker is walking unrestricted within the model.

• We changed the behavior of MU animations of point-oriented objects:

• If an MU animation path consists of more than one point and if you did not enter a time or speed
respectively the MU animation now takes exactly as long as the processing time.

Simulation and Animation Relevant Changes
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• Failure, pause, etc now interrupt MU animations, which consist of more than one point, on point-
oriented objects.

Back to What’s New in Tecnomatix Plant Simulation 16

New Features of the Material Flow Objects

Tecnomatix Plant Simulation 16.0 provides a number of new features.

New Features in Plant Simulation 16.0

• We added the MU selection > Order Controlled to the Source and the setting Supermarket to the
Store. You can use them to model pulling material flow strategies.
If the respective function is active, the command View > Show Orders of the Source or the Store is
active as well.

• We added the setting Fill whole layer to the Container.

• We added the setting Reset destination when at destination to the tab Routing of the Part and the
Container.

• We added the setting Reset destination when at destination to the tab Routing of the Transporter.

• We added the Delete button to the dialog Reorder Successors. You can click it to delete the
Connector from the selected object to its successor. This is especially helpful when you cannot see the
Connector because you moved the objects really close to each other.

• We added the setting Sequentially indexing to the PlaceBuffer.

• We added the setting Show fill level to the PlaceBuffer. It is only available in a 2D only model.

New Features in Plant Simulation 15.2

• We enhanced the behavior of Plant Simulation. When you insert a sub-Frame into your model Frame,
you now do not have to use objects of type Interface any more if the sub-Frame only contains a
single object in 2D. In this case Interfaces are unnecessary as the incoming and outgoing connection
is unique.

• We enhanced the behavior of the DismantleStation. It can now also remove a certain portion of the
mounting parts from the main part instead of all mounting parts as in previous versions. You can
select this under Sequence, Dismantle Table, and Dismantle mode.
In previous versions all remaining parts were automatically moved to the same successor as the main
part. You can now explicitly activate this behavior:

• Leave the column MU in the Dismantle Table empty to designate any MU class.

1. What's New
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• Type in the value -1 into the column Number to designate all remaining parts of this class.

• Type in the number of the desired successor into the column Successor.

When you load a model that was saved in a version older than version 15.2, and which contains a
DismantleStation using a Dismantle Table, Plant Simulation automatically adds a respective row to
the Dismantle Table to not change the behavior of the DismantleStation during the simulation.

• We enhanced the behavior of the Transporter when you Create a Tugger Train. Now the tractor and
all trailers do not have to touch any more, as long as all Transporters are located all the way on the
same Track. If necessary Plant Simulation moves the other Transporters up to the frontmost
Transporter or the tractor.

• We added the read-only-attribute FwBlockListEntry1 for those objects which have a forward
blocking list. You can use it if you only need the first entry of the forward blocking list. Access is
much faster than with the method fwBlockList.

• We added the method setRouteSegments for the AGV that is not bound to a fixed route network.

• We added the command Split Up to the context menu Segments of the length-oriented objects.

• We added the F7 key to the context menu Segments > Edit of the length-oriented objects. It opens
the Segments table. This applies to 2D and to 3D.

New Features in Plant Simulation 15.1

• We enhanced the behavior of the PickAndPlace Robot. The sensor, at which the robot loads parts
onto a Transporter or a Container, can now also be triggered by the rear or the booking point of the
part.
If you Configure the Pick-and-Place Robot with Drag and Drop Plant Simulation now, by default,
creates a sensor that is triggered by the booking point.

• We added the method reset to the failure profiles.

• We added the read-only attribute IsTriggered for sensors. You can use it to query if a part is located at
the position of the sensor and triggered that sensor.

• We added the command Inherit 'Entrance/Exit Locked' On Reset to the Tools menu.

• We added the attribute IsIdle to the Transporter.

• We added the text box Default curve radius for the AGV to the Transporter. In previous versions you
could only set the default curve radius with the attribute DefaultCurveRadius.

• We added the text box Default curve radius for the AGV to the Transporter.

New Features of the Material Flow Objects
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• We added the text box Rotation speed and the attribute RotationSpeed for the AGV to the
Transporter.

• We added the method drive for the AGV to the Transporter.

• We added the method rotate for the AGV to the Transporter.

Back to What’s New in Tecnomatix Plant Simulation 16

Changed Features of the Material Flow Objects

Tecnomatix Plant Simulation 16.0 provides a number of changed and improved features.

Changed Features in Plant Simulation 16.0

• We changed how you insert length-oriented objects: You now set each curved segments with a single
mouse click, no matter for which check box you activated Fixed.

• We changed what Plant Simulation does when an object changes to the Unplanned state.

• In previous versions the Unplanned control as well as the Pause control were called.

• From version 16 only the Unplanned control is called. For compatibility reasons Plant Simulation
still sets the attribute Pause to true when Unplanned is set to true.

• We changed the behavior of the Pause control and of the Unplanned control. In previous versions
these only supported a single or no parameter. Now you can declare the new parameter NewValue of
data type boolean for both controls:

param Duration:real, NewValue:boolean

If you specify the parameter NewValue, the controls will only be called when the ShiftCalendar
changes the state of the object.
In addition the object will not be put in the desired state. The Pause control or the Unplanned
control have to do this from now on. The desired value is passed in the parameter NewValue.
The part still can be processed all the way before the object changes to the state Paused or
Unplanned.

• We changed the behavior of the Pull control. It is not called any more if an MU is moved onto the
same location, for example in an exit control.

• We enhanced the behavior of the Transporter when you Create a Tugger Train. Now the tractor and
all trailers do not have to touch any more, as long as all Transporters are located all the way on the
same Track. If necessary Plant Simulation moves the other Transporters automatically up to the
frontmost Transporter or to the Tractor.

1. What's New
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• We enhanced the behavior of an empty workpiece carrier.

• In previous versions an empty workpiece carrier was always moved on to the default successor.

• For the following settings of the designated objects Plant Simulation uses the attributes or the
name of the empty workpiece carrier.

■ For the setting Exit > Strategy > MU Attribute of the material flow objects.

■ For the settings Exit behavior > Strategy > MU Attribute and MU Name of the FlowControl.

■ For the settings Attributes > Assembly table > MU Types and Depends on Main MU of the
AssemblyStation.

■ For the settings Attributes > Strategy > MU Attribute and MU Name of the Turnplate.

■ For the settings Attributes > Strategy > MU Attribute and MU Name of the Converter.

■ For the setting Fluid depends on > MU Name of the DePortioner.

• We changed the behavior of the PlaceBuffer: When parts are located in the PlaceBuffer you cannot
change its Capacity any longer. You can only change it when it's empty.

Changed Features in Plant Simulation 15.2

• We changed the behavior when an Interface only has a single successor. From Plant Simulation 15.2
on the exit strategy is not only not going to be evaluated when moving the MU, but also not when
the MU is blocked. An MU is now also moved on or blocked respectively when the Interface with a
single successor only would not have determined a valid successor according to the exit strategy.

• We changed the behavior of the PickAndPlace Robot. If the robot is to load parts onto a Container or
a Transporter at the sensor, it now only picks the part up when a Container or a Transporter waits at
the sensor.

• We changed the behavior of the Default Successor of the exit strategy MU attribute: Type in 0 so
that Plant Simulation shows an error message. We do not support the value -1 any more.

• We added the event CheckMUPosition for length-oriented objects to the list of events in the
EventController.
The event CheckMUPosition is scheduled when the exit control is called and checks, after processing
the exit control, if the MU has to be stopped. This is the case when neither the position of the front
of the part in the direction of movement nor its direction changed.

• We added the optional parameter NextRandomSeedValue to the method derive. It ensures
reproducible simulation behavior when you create objects during the simulation.

Changed Features of the Material Flow Objects
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• We enhanced the behavior of the method setRoute of the Transporter that is not bound to a fixed
route. You can now also specify a DataTable containing the objects of the route in the first column. Or
you can specify a one-dimensional list of data type list.

• We enhanced the behavior of the method setRoute of the Transporter that is not bound to a fixed
route. If a standing Transporter cannot drive to the first Marker using the specified Default curve
radius, the Transporter rotates on the spot, if possible, and then drives in a straight line towards the
Marker.

• We changed the behavior of the attribute Stopped for a tugger train. When you change the state of
the attribute for a trailer, this now stops the entire tugger train or makes it continue on its way.

• We changed the data type of the third parameter of the Connect control. This parameter now has the
data type object instead of boolean. In previous version true/false was passed when the Connector
was created/deleted. Now the Connector is going to be assigned to the parameter if it was created
and VOID is going to be assigned when it was deleted.
The new parameter profile looks like this:

param predecessor, successor, connector: object

The parameter profile of previous versions still works. If the Connect control expects the previous
parameters, Plant Simulation calls it as before. If the Connect control expects the new parameters,
the meaning of the first two parameters changes as well. If you externally connect an Interface of a
Frame, the Frame was passed to the parameter source/destination of previous versions. If the
Connect control expects the new parameters, now the Interface is passed.

Changed Features in Plant Simulation 15.1

• We enhanced access to sensors with the method ID: You can now also use this notation:
<Path>.Sensors.id

• We enhanced the behavior of the methods create and insert of the moving objects: You can now also
create or insert an MU at the beginning of a length-oriented object if a part of the MU hangs in thin
air afterwards, i. e., is not located all the way on the length-oriented object.

• We changed the behavior of the method setRoute of an AGV that is not bound to a fixed route. The
method setRoute can now also contain Tracks and, as the last object, its own AGVPool.

• We changed the parameters of the Move-in-Frame-control. These now only affect the 3D
coordinates.

• We made the attributes HasOrder and DrivingHome of the Transporter observable.

• We renamed the read-only attribute of the Transporter to DistanceObjectBelowLimit.

• We changed the return value of the read-only attributes Location and LocationInFrame. It now is
VOID for the Transporter and the Worker if they move freely within the model.

1. What's New
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Back to What’s New in Tecnomatix Plant Simulation 16

New and Changed Features of the Fluid Objects

Tecnomatix Plant Simulation 16.0 provides a number of new and improved features.

New and Changed Features in Plant Simulation 16.0

• We added the read-only-attributes CurrentMaterialColor and CurrentMaterialDensity to the fluid
objects.

• We enhanced the behavior of the Pipe. When you clear Pipe opened, it now shows the state Pipe
closed in cyan.

New and Changed Features in Plant Simulation 15.2

• We added the drop-down list Position to the dialog Sensors of the Tank. Here you can select if the
position of the sensor is relative or absolute.

• We added the attribute PositionType for the sensors of the Tank.

• We added the read-only-attribute CurrentWeight for the DePortioner, the Mixer, the Portioner, and
the Tank.

• We added the optional parameter PositionType to the method createSensor the sensors of the Tank.

New and Changed Features in Plant Simulation 15.1

We added the command Inherit 'Entrance/Exit Locked' On Reset to the Tools menu.

Back to What’s New in Tecnomatix Plant Simulation 16

New and Changed Features of the Resource Objects

Tecnomatix Plant Simulation 16.0 provides a number of new and improved features.

New and Changed Features in Plant Simulation 16.0

• We added the setting Capacity, the attribute Capacity, and the menu command Contents to the
Workplace.

• We added the setting Stopped and the attribute Stopped to the Worker.

• We added the read-only attribute CurrentSpeed to the Worker.

New and Changed Features of the Fluid Objects

, Plant Simulation 16.0  1-11
© 2020 Siemens



New and Changed Features in Plant Simulation 15.2

We changed the behavior when creating Workers. If no Broker exists during that process, Plant
Simulation sets the attribute AutomaticMediation for the Workers to false.

New and Changed Features in Plant Simulation 15.1

• We added the method getIdleAGV and the read-only attribute NumIdleAGVs to the AGVPool.

• We changed the behavior of the Pick-and-Place-Robot. If you send a pick-and-place robot to a station
with the method setDestination, the MUs on this station are unblocked as follows:

• First an already waiting MUs is unblocked for which the pick-and-place robot was requested.

• If this is not the case, the Pull control is called, of it exists.

• If both is not the case, the MU in the blocking list is unblocked that was scheduled first.

Back to What’s New in Tecnomatix Plant Simulation 16

New and Changed Functions of the Information Flow Objects

Tecnomatix Plant Simulation 16.0 provides a number of new features.

New Features in Plant Simulation 16.0

• We added Oracle19c to the supported Oracle versions.

• We enhanced the behavior of the Method and of user-defined attributes of data type Method. They
now have their own random number stream. To enable this, we added the attribute RandomSeed.
As you are used to from the material flow objects, Plant Simulation automatically assigns the random
number stream when you insert an object, so that each object has its own random number stream.
If you call one of the distribution functions in a Method, the first parameter, which specifies the
random number stream, now is optional. If you do not specify the stream,Plant Simulation uses the
random number stream of the Method or of the user-defined attribute method.
This affects the following distribution functions
z_beta, z_binomial, z_cEmp, dEmp, z_emp, z_erlang, z_frechet, z_gamma, z_geom, z_gumbel,
z_hypgeom, z_laplace, z_logistic, z_logLogistic z_lognorm, z_negexp, z_normal, z_paraLogistic,
z_pareto, z_poisson, z_triangle, z_uniform, and z_weibull.
You can still call the distribution functions with the parameter for the random number stream. For
formulas it is required, as formulas never use the random number stream of the surrounding object.
The random number sequences, which are generated by the random number streams of the
Methods, differ from the random number sequences of the global random number streams, whose
seed values you can set under File > Options > Random Number Seed Values even if they have the
same random number seed value.

1. What's New
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• We added the function str_to_table. It checks if the designated path references a user-defined
attribute of data type table, list, stack, or queue.

• We changed the behavior of the function str_to_method. If the passed path does not reference a
DataTable, it now returns VOID. In Plant Simulation 15.2 and earlier the Method Debugger opened
with a runtime error.

• We added the method cutEmptyRows to the DataTable.

• We added the method countMatches to lists and tables.

• We enhanced the behavior of the command Reformat Selection of the Method Editor. You can now
click anywhere within the source code and select the command to reformat the entire source code
instead of only the selection.

• We added key combinations for searching for the next occurrence of the selected text in the
Method-Editor without having to use the Find dialog:
Ctrl+F3 searches for the next occurrence downwards
Shift+Ctrl+F3 searches for the next occurrence upwards

• We changed how you can edit observers. In previous versions double-clicking a cell in the column
Method opened the dialog of the observer. Now Plant Simulation opens the dialog of the Method to
be executed.

• We enhanced the behavior of a Variable of data type object. Instead of typing in the path of the
object or of selecting the object, you can now also drag the object onto the Variable and drop it there.
Plant Simulation then inserts a reference to the object.

• We removed the tab Communication from the Variable as we do not support DDE any longer.

• We replaced the tag eMPlantTable when exporting DataTables in XML format with the tag
PlantSimulationTable, compare Export XML File. Plant Simulation can still read XML files that were
written by previous versions with the old tag but not vice versa. In addition the written file does not
use a namespace any longer.

New and Changed Functions of the Information Flow Objects
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• We added the comma as column separator to the dialog Text File Format and to the method
ColumnSeparator.

• We added two optional parameters to the function ExecuteSimTalk of the COM Interface. It allows
you to add additional arguments to the SimTalk method to be executed.

• We added an optional parameter to the function StartSimulation of the COM Interface. You can use it
to set that the simulation runs without animation.

New Features in Plant Simulation 15.2

• We changed the look and the functionality of the object OPCUA. It does not display the tab
Communication Statistics any longer. The Profiler now contains the entire OPC UA Communication
Statistics.

• We added the attribute Timeout to OPCUA. This might be necessary to establish the connection with
a slow server.

• We changed the behavior of the Teamcenter Interface. From this version on you do not have to enter
the URL of the Active Workspace Servers any more. Instead, you can now use the setting Use Active
Workspace or the attribute UseActiveWorkspace to activate or deactivate Active Workspace. For this
reason we do not support the attribute AWServerURL any more.
This only works if the Active Workspace URL is set correctly in the Teamcenter data base in the
Preference > ActiveWorkspaceHosting.URL.

• We added the commands Remove Row, Remove Column, and Insert to the context menu of lists
and tables.

• We changed the behavior of lists and tables whose size you limited by entering the number of
columns and the number of rows on the tab Dimension.
In previous version Plant Simulation deleted the existing right-most column or the lowest existing
row respectively when you added a new column or a new row. Thus the number of columns and the
number or rows that you defined did not change.
From this version on Plant Simulation increments the number of columns and the number of rows
respectively when you add columns or rows. It does not delete the existing last column/row any
longer preventing data loss.

• We enhanced the behavior of the method sort of lists and tables. When sorting according to several
columns you can now specify the sort order for each column individually. To do so, enter an array of
data type string, in which you defined the sort order for each column, as the last parameter.

• We changed the behavior of the methods max, meanValue, min, standardDeviation, and sum.
These now treat the boolean value true like 1.0 and the boolean value false like 0.0.

• We do not support the method inheritValue of the Variable any more. You can use the instruction
Variable.inheritAttribute("Value") instead.
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New Features in Plant Simulation 15.1

• We added the command MU and Icon Animation to the View menu and to the toolbar of the
Method-Debugger. You can use it to activate or deactivate MU Animation and Icon Animation
together.

• We enhanced copying source code in the Method Editor. Plant Simulation pastes the copied source
code in a suitable program, for example MS Word, with its color highlighting.
Plant Simulation places the text, in addition to simple text, as RTF Text, on the clipboard.
Suitable programs paste the formatted RTF text or provide options for the format to be pasted,
compare Working in the Method Window.

• We enhanced the functionality of the command Export to File of the Method Editor. You can now
select the format of the text file to be exported. To save color highlighting of keywords and comments
in the source code, you can select HTML Files or RichText Files.

• We enhanced the behavior of the DataTable. You can also use the method setXYWH when a
DataTable is open as a dialog in the foreground.

• We added the setting Use RFC 1006 to the object Socket.
As this functionality makes the method writeString superfluous, we do not support it any more.

• We added the optional parameter HostAndPort to the methods write, writeByte, and writeNullByte
of the object Socket.

• We added the methods getItemValue and setItemValue to the PLCSIM_Advanced Interface.

• We added the attributes OfflineCycleCtrl and OfflineMode to the PLCSIM_Advanced Interface.

Back to What’s New in Tecnomatix Plant Simulation 16

New and Changed Features of the User Interface Objects

Tecnomatix Plant Simulation 16.0 provides a number of new and improved features.

New Features in Plant Simulation 16.0

We changed the behavior of the object GanttChart. For parts being transported by a Transporter or
carried by a Worker, it now shows the Transporter or the Worker as the resource instead of the Track or
the Footpath.

New Features in Plant Simulation 15.2

• We extended the behavior of the object HtmlReport. It can now also display a Sankey Diagram.
You can use the keyword %planningview to show the planning view of a 3D-Only-Model,
compare Display a Frame.

New and Changed Features of the User Interface Objects

, Plant Simulation 16.0  1-15
© 2020 Siemens



• We added the method setActiveTabPage to the Dialog.

• We improved adding Annotations to the Chart. You can now select the type of the annotation from a
list instead of entering a number.

• We no longer support the attribute Markers of the Chart. If you have models that still use it, we
recommend to remove the instruction from the source code.

New Features in Plant Simulation 15.1

• We added the tab Attributes to the GanttChart. Until now you could only specify these settings with
attributes and methods.

• We added the methods getInvestmentCostsTable and getPieceCostsTable to the CostAnalyzer.

• We changed the behavior of the method update of the object Display. The method does not have a
return value any more and the parameter is optional and will be ignored.

• We enhanced the method setLineStyle of the Chart.
The parameter LineStyle now is more flexible. You can pass a shortened string to the method, which
has to have a length of least three characters. You can, for example, now pass ". ." or ". . ." instead of
". . . . . . . . ." to create a dotted line. You can also pass "_ _" instead of "_ _ _ _ _ _" to create a dashed
line.
You can also pass minus signs instead of underscores, for example "- -" instead of "_ _".
The parameter LineWeight is optional. If you do not pass it, Plant Simulation keeps the previous
LineWeight.

• We changed the behavior of the Chart. When you selected Reapply at Init in the Statistics Wizard, the
Chart will not be opened automatically when you initialize the model with Init. This had a negative
effect on the performance of the ExperimentManager.

Back to What’s New in Tecnomatix Plant Simulation 16.0

New 3D Features

Tecnomatix Plant Simulation 16.0 provides a number of new features.

New Features in Plant Simulation 16.0

• We significantly enhanced and simplified recording videos, compare Start Simple Recording and
Start Simulation Recording.

• We added the command Create Tugger Train to the Context Menu for Several Selected Objects.
We enhanced the behavior of the Transporter when you Create a Tugger Train. Now the tractor and
all trailers do not have to touch any more, as long as all Transporters are located all the way on the
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same Track. If necessary Plant Simulation moves the other Transporters up to the frontmost
Transporter or the tractor.

• We enhanced the display of the WorkerPool. You can show the Workers either on an animation path
or on an animation area.

• We enhanced the display of the Workplace with a Capacity of more than one Worker. You can show
the Workers either on an animation path or on an animation area.

• We enhanced the behavior of the Drop-Down List in 3D. It can now also display Captions.

• We added the method moveTo for joints of animatable objects.

New Features in Plant Simulation 15.2

• We added the command Split Up to the context menu Segments of the length-oriented objects.

• We extended the behavior of the commands Make Simulation Object and Make Animatable
Object. You can now also call these commands when you selected several graphics at the same time.

• We added the six-axis robot to the robot types which the PickAndPlace robot recognizes, compare
Configure the Robot in 3D.

• We added the setting Origin to the appearance of the Store. You can select the origin for the graphic
in the X direction and the Y direction. The origin sets if the insertion point of the object is the center
or the left/lower or the right/upper border of the graphic.

• We extended the functionality of the command Import Graphics. It can now also import NX Files
(*.prt).

• We added the setting Preserve references to the dialog Optimize Selected Graphic. If you optimize
your model, Plant Simulation applies this setting as well. This also applies to the method
_3D.optimizeObject. For the method _3D.optimizeObject this is a non-simulation-relevant change.

• We added the command Add Animatable Object to the Context Menu of a Simulation Object in
the dialog Show 3D Graphic Structure.

• We changed the function of the command Show 3D Graphic Structure. It now always displays
additional information for the graphics.

• We added the method _3D.Poses.moveToCoordinate. The method allows an object, for which you
can define pose, to move to a coordinate with a certain destination orientation without having to
define a pose. It thus simulates a pose movement that resembles robot kinematics.

• We added the key combination Shift+double-click to context menu command Open in New 3D
Window.

New 3D Features
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• We introduced functions for the Page Up key and the Page Down key.
Depending on your selection the Page Up key executes the following:

• If you select the first manipulator of a length-oriented object, Plant Simulation elongates the
neighboring segment towards this manipulator. The object thus becomes longer.
A linear segment is elongated in a linear way. For a horizontal curved segment the curve angle is
increased. For a vertical curved segment the Page Up key has no effect.
If you select the last manipulator of a length-oriented object, Plant Simulation shortens the
neighboring segment towards this manipulator. The object thus becomes shorter.
A linear segment is shortened in a linear way. For a horizontal curved segment the curve angle is
decreased. For a horizontal curved segment the Page Up key has no effect. Compare Edit
Manipulators with Keyboard Keys.

• If you select a sensor, the Page Up key moves the sensor to the left. The left arrow key does the
same. Compare Edit Sensors with Keyboard Keys.

• If you select an animatable object, which shows a pose state while editing a pose, the Page Up
key moves the joint according to its degree of freedom towards its lower limit. The left arrow key
does the same. Compare Move Poses and Joints with Mouse and Keyboard Keys and Moving
the Robot in 3D with Mouse or Keyboard.
If the object is not an animatable object, the offset is 10 % of the grid line distance that is used for
snapping. By default this is 10 % of 1 m, i.e., 10 cm.
If the object is an animatable object, the offset is described under Move and Rotate Poses on the
3D Quick Reference Card. If you hold down the Shift key, it is ten times the value, i.e., the grid
distance itself, etc. If you hold down the Ctrl key, it is a tenth of the value, i.e., 1 % etc.

Depending on your selection the Page Down key executes the following:

• If you select the first manipulator of a length-oriented object, Plant Simulation shortens the
neighboring segment towards this manipulator. The object thus becomes shorter.
A linear segment is shortened in a linear way. For a horizontal curved segment the curve angle is
decreased. For a vertical curved segment the Page Down key has no effect.
If you select the last manipulator of a length-oriented objectt, Plant Simulation elongates the
neighboring segment towards this manipulator. The object thus becomes longer.
A linear segment is elongated in a linear way. For a horizontal curved segment the curve angle is
increased. For a vertical curved segment the Page Down key has no effect.

• If you select a sensor, the Page Down key moves the sensor to the right. The right arrow key does
the same.

• If you select an animatable object, which shows a pose state while editing a pose, the Page Down
key moves the joint according to its degree of freedom towards its upper limit. The right arrow
key does the same.
For an animatable object, the offset is described under Move and Rotate Poses on the 3D Quick
Reference Card. If you hold down the Shift key it is ten times the value, i.e., the grid distance
itself, etc. If you hold down the Ctrl key, it is a tenth of the value, i.e., 1 % etc.
If the object is not an animatable object, the offset is 10 % of the grid line distance that is used for
snapping. By default this is 10 % of 1 m, i.e., 10 cm.
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• We extended scene manipulation with the 3D mouse in Planning View. The axes now correspond to
those that are also used in modeling view.

New Features in Plant Simulation 15.1

• We added the Shape > Dimensioning. You can use it to measure the distance between objects and
the dimensions in the 3D window. To do so, we also added the SimTalk functions
createDimensioning, DimensioningSpace, MeasuredLength, MeasuringPoint1,
MeasuringPoint2, and TextPosition.

• We added the setting Edging to the Cuboid. You can use it to add colored lines to the edges of the
Cuboid.

• We enhanced the functionality of the method createCuboid. You can now also create a flat wall by
entering 0 for one of the dimensions.

• We redesigned the dialog for creating a rack.
We added the settings board thickness, ground clearance, post diameter, and post form to the
rack.
We added the optional parameters SquarePosts, PostDiameter, BoardThickness, and GroundClearance
to the method createRack.

• We enhanced the functionality of the method createRack with an additional parameter. The board
thickness now is no longer part of the height of a storage compartment and the height of the
individual compartments is reduced by the board thickness of 3 cm.
The overall height of the rack is increased by 3 cm each for each shelf.

• We added new types and additional settings for these types to the Store in 3D.

• We enabled multiple paste of shapes and graphics: Select the shape/graphic, hold down the Ctrl key
and click on the positions in the Frame in the 3D window at which you would like to place the
instances.

• We added the base plate material to the Grid and Base Plate Settings. It replaces the base plate
color that previous versions of the program provided.

• We added settings for acceleration, deceleration, and preview translation/rotation of the joints to
the Tab Joint.

• We added the radio buttons Relative/Absolute for objects with animation area to the tab MU
Animation. They activate the text boxes for the respective settings and deactivate the text boxes for
the other settings. This makes entering values easier.

• We enhanced the functionality of the robot in 3D. You can now move it with the mouse, compare
Move the robot in 3D with the mouse.

New 3D Features
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• We added buttons to the dialogs Make Animatable Object and Make Simulation Object. You can
click them to set the object position to values, which result from the bounding box of the graphic to
be converted.

• We enhanced the functionality of the command Make Animatable Object. After you created it, Plant
Simulation now opens the dialog Edit 3D Properties with the tab Joint.

• We enhanced the functionality of the command Copy. You can now also copy and cut graphics which
are contained in other graphics.

• We added the command Reorder Successors to the Context Menu of the Selected Simulation
Object.

• We added the method _3D.getMUAnimationPosition.

• We added the method _3D.getRotationOfObject.

• We added the method _3D.getWorldRotation.

• We added the method _3D.MUAnimations.<AnimationPathName>.getMUAnimationPosition.

Back to What’s New in Tecnomatix Plant Simulation 16

Changed 3D Features

Tecnomatix Plant Simulation 16.0 provides a number of changed and improved features.

Changed Features in Plant Simulation 16.0

• We changed how Plant Simulation shows a newly created simulation frame. A simulation frame is a
Frame that contains an EventController and in which you run simulations. The EventController is now
located zoomed in the left top corner in whose vicinity the origin of the grid now also is located.

• We changed how Plant Simulation opens new 3D windows: As to the visibility of grid and base plate
these are now always opened independent of what was set in a 3D window. Until now this was only
the case for Frames. Other 3D windows always used the last selected setting, no matter if you opened
it from a 3D Frame window or from another 3D window.

• We changed the transparency of the base plate material, to better see if objects are located below
the base plate.

• We removed the spin buttons from the 3D dialogs as they reduced the performance of the program.
Instead you can:

• Roll the mouse wheel forward to increase the value, compare Move and Rotate Objects in the 3D
Quick Reference.
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• Roll the mouse wheel back to decrease the value.

• Press the Left, Right, Up, or Down arrow keys, compare Move and Rotate Objects in the 3D
Quick Reference.

• We changed the behavior of extrusion configurations that are repeated in equidistant sequences, for
example the legs of a conveyor.

• In previous versions these were equidistant according to the length projected onto the XY plane.

• Now they are equidistant according to the length in space. This looks better if they occur in vertical
curves or with a height offset.

• We changed the behavior of the command Show External Graphic Groups  on the

View ribbon tab:

• For the Frame you can show or hide external graphics by clicking the button.

• For 3D windows of all other objects the button is permanently activated .

• For the 3D window of a folder the button is permanently deactivated .

• We changed the behavior of the option Optimize 3D attribute inheritance in the dialog Optimize
Model. Optimize 3D attribute inheritance no longer suppresses the optimization of graphics
inheritance.

• We changed license checking for the subcommands of the command Export Scene:

• If you run Plant Simulation with a Viewer license the subcommands are no longer grayed out.
Once you select one of these commands. Plant Simulation shows this message.

• When you export the scene with the methods _3D.exportAsBitmap, _3D.exportAsJt, or
_3D.exportAsS3D a Debugger message alerts you that this is not allowed with the Viewer license.

Changed 3D Features
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• We added an optional parameter to the method _3D.exportAsJt. It sets if the graphic of the object is
exported with all of its components or if the components that are not visible if you opened the object
in a 3D window are not exported.

• We added an optional parameter to the method F3DPauseVideo.

• We made the parameters YUpToZUp and MoveContentToZero of the method importGraphics
optional.

• We made the parameter Pose of the _3D.Poses.getAnimationTime optional.

• We removed support of the method _3D.deletePlainGraphics. You can use the method
_3D.deleteGraphicGroupContent instead.

• We removed support of the method _3D.getAnimationPoint. You can use the method
_3D.getMUAnimationPosition instead.

Changed Features in Plant Simulation 15.2

• We changed the behavior when importing a 3D graphic with the command Import Graphics or with
drag and drop from the Windows Explorer. Plant Simulation now automatically zooms the view to this
graphic.
To prevent zooming, hold down the Shift key before clicking OK in the dialog Insert Graphic.
Zooming can, for example, be annoying if you want to import several JT graphics to certain positions
and when Plant Simulation continuously changes the scene when doing so.

• We changed the behavior of an animatable object with a joint velocity of 0 on a Turntable. The
animatable object now does not rotate with the Turntable if the Turntable rotates. You can use this to
model a fixed base for the Turntable around which the turntable proper rotates.

• We enhanced the behavior when automatically connecting Sources and Drains. These are now
connected on all four corners with the Connector.

• We changed the behavior when moving several objects at the same time with the mouse. If Connect
objects automatically is active, Plant Simulation only connects the selected objects with other, non-
selected objects, but not with each other.

• We extended the behavior when you duplicate objects with Ctrl+drag-and-drop. Plant Simulation
now selects the duplicated objects in the scene window, just as when you copy and paste object.

• We changed the behavior of the dialog Optimize Model. When you hold down the Shift key while
clicking Optimize and when Optimize 3D attribute inheritance is active, Plant Simulation does not
optimize inheritance of the graphic and of the states.
This is useful to suppress this optimization if it would take too long.

• We changed the behavior when you opened the dialog Edit 3D Properties of a simulation object and
when you changed a value on the tab Transformation. In previous versions the preview of the
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changed value triggered a Move in Frame control which caused Worker paths to be computed anew.
From this version on Worker paths are not computed anew any longer.

• We renamed the function basis._~._3D.concatenateRotations to F3DconcatenateRotations.

• We changed the behavior of the method makeAnimatableObject and of the commands Make
Simulation Object and Make Animatable Object. If the graphic, from which animatable object is
created, is not part of the default graphics group, the commands create a graphics group with the
name of the graphics group where the graphic to be extracted is located. In previous versions Plant
Simulation created the graphics group within the default graphics group.

• We renamed the functions basis._~._3D.generate... to F3DgenerateEllipse,
F3DgenerateHollowEllipse, F3DgenerateHollowRectangle, and F3DgenerateRectangle.

• We removed the slider from the settings Transparency and Shininess from the dialog Material and
the tab Appearance. You can now only enter values into the text boxes.

Changed Features in Plant Simulation 15.1

• We changed how Plant Simulation recognizes the number of axes of a robot to be imported. Compare
Configuring the Pick-and-Place Robot in 3D.

• We changed for which objects you can create internal graphic groups. You can now only do that for
Frames.
For all objects, except for the Frame, we removed the column Internal on the tab Graphics in the
dialog Edit 3D Properties. The context menu command is grayed out in the dialog Show Graphic
Structure. In existing models all graphic groups are treated as external, independent of the setting
you chose.
For this reason these SimTalk functions are only available for the Frame: _3D.InternalGraphics,
_3D.isGraphicGroupInternal, _3D.setGraphicGroupExternal, and _3D.setGraphicGroupInternal.
The parameter Internal of the method _3D.addGraphicGroup now is optional and is only available
for the Frame as well.

• We enhanced the message dialogs that Plant Simulation shows when, for example, calling the
command Exchange Graphics when the dimensions an MU graphic do not match the physical
dimensions. These messages now also contain information about the booking point and highlight the
value pairs that actually changed.

• We removed the setting Show Grid from the tab 3D in the dialog Preferences. For this reason we do
not support the attribute basis.~._3D.GridVisibleInNewWindows any longer.
Instead, you can show or hide grid and base plate with the buttons Show Grid and Show Base Plate
on the View tab individually and separately.

• We removed the text box Curve precision from the tab 3D in the dialog Preferences. For this reason
we do not support the attribute _3D.CurvePrecision any longer.
To control curve sampling of polycurves and splines, we now use a common dynamic mechanism
which is independent of the curve radius.

Changed 3D Features
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This change can alter simulation results in models with length-oriented objects with curve segments,
if a Worker is walking unrestricted within the model.

• We changed how the planning view shows state graphics. 3D now hides the placeholders for state
graphics. The state of an object with perpendicular state marker is now shown as a small colored dot.

• We changed how line and point graphics, for example Dimensions, are shown. These do not throw
any shadows any more.

• We changed the behavior of the Worker on point-oriented objects. You cannot run the animation for it
depending on the simulation time. For this reason the Worker does not support the method
_3D.resetAnimationTime any more.

• We changed the behavior of MU animations of point-oriented objects:

• If an MU animation path consists of more than one point and if you did not enter a time or speed
respectively the MU animation now takes exactly as long as the processing time.

• Failure, pause, etc now interrupt MU animations, which consist of more than one point, on point-
oriented objects.

• We changed the behavior when adding new animation paths on the tab MU Animation if no MU
animation paths are created yet for the default cases of the object. Now the text box Path name
shows the ellipsis button . When you click it, Plant Simulation opens a dialog with suggestions for
path names which are not yet mapped to existing MU animation paths. The list is limited to 100
entries.
The individual paths for individual MUs on the PickAndPlace-robot, the PlaceBuffer, the AGVPool, or
the WorkerPool are not considered here as they do not have a fixed path name.

• We changed the behavior when optimizing a graphic with the command Optimize Graphic > Step 2:
Flatten structure without the option Keep grouping being active. When you optimize a graphic with
this command or when you export a graphic or when you optimize the model with the command
Optimize Model > Optimize 3D graphic structure, Plant Simulation now deletes ungrouped
graphics, which do not contain any other graphics. When exporting a graphic this only takes place in
the exported .jt file.

Back to What’s New in Tecnomatix Plant Simulation 16

New and Changed SimTalk Features

Tecnomatix Plant Simulation 16.0 provides a number of new and improved features.

New and Changed Features in Plant Simulation 16.0

• We added JSON to the SimTalk data types.
We added the keyword json.
We added the data type json to the Variable.
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• We added the function BitClear.

• We added the optional parameter MakeAbsolute to the function obj_to_str.

• We added the optional parameter forceUpdateNow to the function updateGUI. You can use it to force
Plant Simulation to immediately update the user interface.

• We removed support of the function HTMLHelp.

New and Changed Features in Plant Simulation 15.2

• We extended the behavior of the operators += and -=. For objects of type Variable and for user-
defined attributes of data types time, length, weight, speed, and acceleration these now check the
type more stringent than before, compare Arithmetic Operators. The following source code will now,
for example, cause an error:

var len : length
VariableObjectOfTypeSpeed += len  -- no longer allowed
len += VariableObjectOfTypeSpeed  -- was never allowed

• We changed the behavior of the functions pow and sqrt, compare Basic Mathematical Functions.
They now also support the use of physical units.

• We extended the behavior of SimTalk 2.0. You can now also enter units for speed and acceleration.
Enter the unit directly after the number, without a separating blank space, for example 42mph or
42.0mph.
For the speed you can type in these units: mps (meters per second), fps (foot per second), kmh
(kilometers per hour), and mph (miles per hour).
For the acceleration you can type in these units: mps² (meters per second squared) and fps² (foot
per second squared).

• We extended the behavior of SimTalk 2.0. You can now also enter the unit s for seconds. Enter the
unit s directly after the number, without a separating blank space. Entering the unit sometimes is
necessary to make sure that the computed expression has the correct data type.

var x : length := 10m
var s : speed := x / 2s   -- Beware: x/2 would have the 
                          -- wrong unit, m instead of m/s

• We added an optional parameter to the method sort of arrays. It enables you to sort the array in
ascending or descending order.

• We added the method normalize for arrays of data type real.

• We replaced the function SHGetFolderPath with the function SHGetKnownFolderPath.

New and Changed SimTalk Features
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• We enhanced the behavior of the methods messageBox, prompt, promptList1, and promptListN.
You can now also set the text with them that is shown in the title bar of message dialogs.

• We renamed these functions for editing variables of data type string to better recognize them as
string functions:

Outdated Replaced by

ascii strAscii

chr strChr

copy strCopy

incl strIncl

omit strOmit

pos strLPos

toLower strToLower

toUpper strToUpper

trim strTrim

Note:

Models you created in previous versions might not work any longer if you use the new names as
names of variables.

Outdated SimTalk Names

Outdated Replaced by

basis.~._3D.closeAllWindows closeAllWindows

basis.~._3D.generateEllipse F3DgenerateEllipse

basis.~._3D.generateHollowEllipse F3DgenerateHollowEllipse

basis.~._3D.generateHollowRectangle F3DgenerateHollowRectangle

basis.~._3D.generateRectangle F3DgenerateRectangle

_3D.MUAnimations.<AnimationPathName>.getPosi
tionAt

_3D.MUAnimations.<AnimationPathName>.get
MUAnimationPosition

ActReceiver no longer supported, EventController

ascii strAscii

AWServerURL no longer supported, UseActiveWorkspace

chr strChr

copy strCopy

deleteBreakpoint no longer supported, EventController

getBreakpointCondition no longer supported, EventController

getBreakpointReceiver no longer supported, EventController
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Outdated Replaced by

getBreakpointSender no longer supported, EventController

getBreakpointStartTime no longer supported, EventController

getBreakpointStopTime no longer supported, EventController

getBreakpointTraceFile no longer supported, EventController

getBreakpointType no longer supported, EventController

incl strIncl

ModifyStructure LockStructure

omit strOmit

pos strPos

setBreakpointCondition no longer supported, EventController

setBreakpointReceiver no longer supported, EventController

setBreakpointSender no longer supported, EventController

setBreakpointStartTime no longer supported, EventController

setBreakpointStopTime no longer supported, EventController

setBreakpointTraceFile no longer supported, EventController

setBreakpointType no longer supported, EventController

SHGetFolderPath SHGetKnownFolderPath

toLower strToLower

toUpper strToUpper

trim strTrim

New and Changed Features in Plant Simulation 15.1

• We added lists of the Outdated SimTalk Names in 2D and of the Outdated SimTalk Names in 3D.

• We restricted the support for SimTalk Version 1.0 in the Method Editor.

• We deactivated syntax-controlled indentation and formatting of the source code for SimTalk
Version 1.0.

• We removed color highlighting of keywords, which only exist in SimTalk, and outlining of
structures specific to SimTalk Version 1.0.

• We removed inserting of structures specific to SimTalk Version 1.0 via templates.

• We added the method inheritAttribute. It replaces these obsolete methods.

New and Changed SimTalk Features
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Obsolete Method Replaced by Method

inheritPosition inheritAttribute("Coordinate3D")

inheritSizeAndOrientation inheritAttribute("ZoomX")

inheritAttribute("ZoomY")

inheritAttribute("ObjectAngle")

InheritGraphicVisibilities _3D.inheritAttribute("VisibleGraphicGroups")

• We extended the behavior of the waituntil and the stopuntil statement. It now can now also
observe expressions for which only the last part of the path is observable. Up until this version you
could not observe Station.Origin.Name for example, as Origin is not observable.
Up until this version you had to write:

var o : object := Station.Origin 
waituntil o.Name = "a"

This is not required any more.
Note that it can be more efficient though to assign the object to be observed to a local variable as
before and use it in the waituntil/stopuntil statement. If you are observing the condition
Station.Origin.Name = "a" for example and if the name of the observed object changes very
often before "a" is finally assigned, the entire observed condition is evaluated anew each time the
name changes.

Back to What’s New in Tecnomatix Plant Simulation 16

Miscellany

Tecnomatix Plant Simulation 16.0 provides a number of new and improved features.

New and Changed Features in Plant Simulation 16.0

• We adapted the look of the dialogs and windows of Plant Simulation 16.0 and to the look of the
Siemens Digital Industry Software applications. The background of the dialogs is now white for
example.
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• We added the Plant Simulation Foundation License.

• We adapted the Help menu to accommodate the new Siemens Industry Software Support Center.

• In addition to the chm file, we now provide the English, the Japanese, and the Russian online help
for Plant Simulation 16.0 on the Web in the Siemens Industry Software Support Center. Web help
runs on the most recent versions of Google Chrome, Firefox, and Microsoft Edge. We expect the
Japanese and the Russian online help to be available in November 2020.
To use the chm help file from the Plant Simulation Installation, create the registry key
UseInternalOnlineDocu in the Registry Editor and type in 0 as the value. The value 1 shows the
Web help.

Miscellany
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For technical reasons we cannot provide the German online help on the Web yet.

• We added the topic Updating an Old Model to the Current Version to the online help. It
demonstrates how you can use the new functions of the current version of Plant Simulation in a
model that you created in a previous version of the program.

• We improved the arrangement of the Topics and of the Examples in the Example Models
Collection.

• We changed the behavior of the command Compare Models. From this version on Plant Simulation
does not consider attributes any more which inherit their value. If the attribute value of a class
changes, only the class is shown as changed, but not all instances of this class.

• We changed the behavior when pressing Ctrl+Tab, compare Changing between Docking Windows
and Object Windows.
In previous versions Ctrl+Tab only changed from object window to object window. Now Ctrl+Tab
opens the Windows Navigator and shows a preview of the docking windows and of the opened
object windows. The window navigator stays open until you release the Ctrl key again.

The Active Docking Windows are listed on the left and the Active Object Windows on the right.
The left arrow key and the right arrow key change between the columns Active Docking Windows
and Active Object Windows.
The tab key or the up/down arrow keys change between the windows within a column. Releasing
the Ctrl key activates the selected window.
If the focus is located on a docking window, Ctrl+Tab changes between the docking windows.
If the focus is located on an object window, Ctrl+Tab changes between the object windows.

• We removed the visualization setting 2D and 3D from the Preferences. From now on you can only
create new simulation models either in 2D only or in 3D only.

• We added the button Show Movable Units to the dialog Show Structure.

• We added the method showObject for all objects. It shows the object in the Frame or in the folder.

1. What's New

1-30  , Plant Simulation 16.0
© 2020 Siemens



• We changed the behavior of the licensing mechanism. For security reasons new license files do not
contain a WebKey. For this reason it will no longer be shown in the dialog File > Help > About
Tecnomatix Plant Simulation. It is no longer available for user-defined licenses as Host ID.

• We changed licensing with a dongle from WIBU to Sentinel, compare Installing the Sentinel Driver.

• We enhanced the behavior of Pack and Go. When creating a Pack-and-Go-model you can now decide
if you want to restrict the model permissions to the permissions of a Viewer license. Then you have to
pass the license to be used to Pack and Go with the start parameter /L.

• We changed the behavior of the high contrast mode. Plant Simulation now creates pictures and
HTMLReports as if high contrast mode is turned off.

New and Changed Features in Plant Simulation 15.2

• We added the topic Plant Simulation for Beginners to the Online Help. It provides a short overview
over Plant Simulation and introduces the underlying simulation concepts. We also moved the Tutorial
here and built the simulation models in 3D.

• We added key combinations for zooming the contents of the Frame:

• To zoom the contents of the Frame in, you can:
Hold down Ctrl and press +
Hold down Ctrl and roll the mouse wheel up

• To zoom the contents of the Frame out, you can:
Hold down Ctrl and press -
Hold down Ctrl and roll the mouse wheel down

• To restore the original size of the contents of the Frame, you can:
Hold down Ctrl and press 0 (zero)

• We changed the sequence in which the Rename control and the Relabel control are being called.
From this version on the control is first called for the renamed or relabeled object and then for the
inheriting objects.

• We added the setting Initial value to the user-defined attributes.
These now also provide the attributes HasInitValue, InheritHasInitValue, InheritInitValue, and
InitValue.

• We enhanced the behavior of the user-defined attributes. When you created a user-defined attribute
that references an object, you can double-click it in the column Name on the tab User-defined to
open it. Hold down Ctrl and double-click it to show the referenced object at its location and to select
it.

• We changed our licensing mechanism to the Common Licensing Toolkit 11.0. For this reason you now
need a license server of Version 11 or higher.

Miscellany
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• We reduced the units for the acceleration under Preferences > Units > Acceleration and Model
Settings > Units > Acceleration to these four units: m/s², cm/s², ft/s², and LU/s².

• We changed the conversion of the speed units mph (miles per hour) and m/s (meters per second)
under Preferences > Units > Speed and Model Settings > Units > Speed:

Up to and including Plant Simulation 15.1 1 mph = 0.444444 m/s or 1m/s = 2.25 mph

From Plant Simulation 15.2 on 1 mph = 0.44704 m/s or 1m/s = 2.236936 mph

• We added the read-only attribute IsLocked to the folder in the Class Library. It returns if the
designated folder is a locked library.

• We added an optional parameter to the Open control of all objects except the DataList and
DataTable. It applies when the object is located within a locked library or a locked folder.

• We added an optional parameter to the method sort of arrays. It enables you to sort the array in
ascending or descending order.

• We replaced the attribute ModifyStructure with the attribute LockStructure.

• We removed support for DDE.

New and Changed Features in Plant Simulation 15.1

• We changed the behavior of Plant Simulation. You cannot activate or deactivate MU Animation and
Icon Animation separately any more. Activating/deactivating MUs and Icons activates/deactivates
MU Animation and Icon Animation together.
For this reason we do not support the methods animMU and animIcon any longer.

• We added the setting Create backup files with time stamp to the Preferences.

• We extended the behavior of drag and drop, compare Drag an Object Onto Another Object and
Drop It There.
When you drag an object into a window that expects text or into a text box which expects an object
path and drop it there, you can now hold down the Shift and Ctrl keys to insert the absolute path of
the object. If you do not hold down these keys, Plant Simulation inserts the relative path to the object
instead of the object.

• We added the command Edit User-Defined Attributes to the dialogs Show Structure and Show
Inheritance.

• We changed the behavior for user-defined attributes of data types method, table, list, stack, and
queue. You can now double-click the column Value to open the respective object instead of the user-
defined attribute.
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• We replaced the file extension of object files, which you save or export, from .obj to .psobj. As the file
extension .obj is also used by other programs, Plant Simulation could not show a preview of object
files with the file extension .obj.

• We improved readability and look of the What's This help. It now contains formatted text and has a
better window size.

Back to What’s New in Tecnomatix Plant Simulation 16

What's New in Tecnomatix Plant Simulation 15

What's New in Tecnomatix Plant Simulation 15

Tecnomatix Plant Simulation 15 provides a number of new and improved features.

• Important Changes in Plant Simulation

• Simulation- and Animation-Relevant Changes

• New Features of the Material Flow Objects

• Changed Features of the Material Flow Objects

• New and Changed Features of the Fluid Objects

• New and Changed Features of the Resource Objects

• New Features of the Information Flow Objects

• Changed Features of the Information Flow Objects

• New and Changed Features of the User Interface Objects

• New and Changed SimTalk Features

• Miscellany

• New 3D Features

• Changed 3D Features

• New and Changed Features in the Object Libraries

What's New in Tecnomatix Plant Simulation 15
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Note:

As opposed to the full versions, for example Tecnomatix Plant Simulation 15.0, we only support
English and German as the user interface language for the intermediate versions, for example for
Tecnomatix Plant Simulation 14.1.

Back to What’s New

Important Changes in Plant Simulation

We made important changes in Tecnomatix Plant Simulation 15. For this reason you have to adapt
simulation models which you created in previous versions of Tecnomatix Plant Simulation, when you
open them in Tecnomatix Plant Simulation 15.

Important Changes in Plant Simulation 15.0

• We added the object AGVPool to the Resource Objects. You can use it to create automated guided
vehicles for your installation that are not bound to a fixed route network.
We also added the object Marker. You can use it to set waypoints along which the AGVs drive from
the AGVPool to its destination.

Note:

In the current version the SankeyDiagram does not record the AGV, that is not bound to a fixed
route network.

• We added the object CostAnalyzer .

To facilitate cost analysis, we also added the tab Costs to the material flow objects and the tab Costs
to the Part and to the Container.

Note:

The CostAnalyzer and the tab Costs are only available in the Professional License.

Important Changes in Plant Simulation 14.2

• We added the tabs Poses and Joint to the 3D Properties. Together with the joints you can define joint
kinematics.

• We added the sub-tab Transport to the tab Importer. In this context we moved the settings for the
Exit strategy > Carry part away from the tab Exit to this sub-tab. These settings replace the Exit
strategy > Carry part away.
If you query the exit strategy with the attribute ExitStrategy, the return value is not carry part away
any more. For this reason you have to change models that query this return value by using the
attribute TransportImp.Active.
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Note:

If you neither entered an MU target into the transport importer nor a Destination into the part,
the object uses the strategy for determining the destination, which you entered on the tab
Exit.

• We changed where Plant Simulation places duplicated or derived classes when you duplicate or
derive one of the built-in classes in the Class Library. You now find the new class in the folder User
Objects.
When you create a new model this model is now called Model.
The sample Frame in the folder UserObjects is now called MyFrame. It contains, by default, an
Entrance Interface, a Conveyor, a Station, and an Exit Interface.

• We changed the names of the information flow objects below. Now the names of the list objects
match the names of the data types.

Up to Version 14.1 From Version 14.2 on Data Type

TableFile DataTable table

CardFile DataList list

StackFile DataStack stack

QueueFile DataQueue queue

The topic The Conveyor shows how to use the new name instead of the old name when updating a
model to the current version.

Important Changes in Plant Simulation 14.1

• We changed the names of the following material flow objects in Plant Simulation 14.1:

Up to Version 14.0 From Version 14.1 on

Assembly AssemblyStation

Line Conveyor

ParallelProc ParallelStation

SingleProc Station

Entity Part

• We added the object GanttChart. It replaces the GanttChart and the GanttWizard that previous
versions of Plant Simulation provided. The GanttChart visualizes parts on resources.
This affects the GanttWizard and the object GanttChart as follows:

• If you are using the GanttWizard, you just have to update it under Manage Class Library.

• If you are using the GanttChart of previous versions, you have to:

Important Changes in Plant Simulation
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■ Replace the GanttChart with the GanttChart of the current version.

■ Adjust the source code, which you programmed in SimTalk of previous versions, to the current
version, compare Methods of the GanttChart and Attributes of the GanttChart.

Back to What’s New in Tecnomatix Plant Simulation 15

Simulation and Animation Relevant Changes

We made changes that are relevant for the simulation and the animation in Tecnomatix Plant
Simulation 15. For this reason you have to adapt simulation models, which you created in previous
versions of Tecnomatix Plant Simulation, when you open them in Tecnomatix Plant Simulation 15.

Simulation- and Animation-Relevant Changes in Plant Simulation 15.0

• We changed the behavior of the outdated function methcall of the Method. The method now behaves
again in exactly the same manner as in Plant Simulation 14.2 and in previous versions. The active
element (@) now is void again as in version 14.2.

• We changed the behavior of the method getRouteLength of the MUs. It returned the value -1 up to
and including version 14.1. From version 14.2 on the method returned the value
1.79769313486232e+308. In this version the method returns -1 again.

• We changed the behavior of the method delete of the DataTable. If you activated the setting Column
index belongs to contents in previous versions, the following instructions also deleted the column
index:

DataTable.delete({"ColumnB", *})

As this is unexpected behavior and is desired in rare cases only, Plant Simulation does not delete the
column index any more from version 15 on.
If you would like to delete the column index as well, to have to explicitly include the column index
with the instruction:

DataTable.delete({"ColumnB",0}..{"ColumnB",*})

The range definition {"ColumnB", *} now only sets the contents of the DataTable. The index is not
contained any longer if it belongs to the format. Compare Entering a Range of Cells.

• We changed the behavior of the method appendRow of the DataTable. In previous versions the
method overwrote a row if the DataTable with activated row index if the DataTable only contained a
single entry in the row index. This is not the case any more.

• We changed the call sequence of controls of the Exporter and of the Worker. In previous versions it
could happen that the Order control was executed before the Release control of the Exporter or that
the Order control was executed before the Release control of the Worker when moving an MU. In
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this context the call sequence of the Entrance control and of the Order control changed as well.
From this version on the Entrance control is executed before the Order control.

• We changed how the legs of graphics of type > Floorspace for a Store look. These now also have a
square foot print. This may cause different simulation results in models in which Workers walk
underneath the Store and for which you selected Worker obstacle > Graphics.

Important Changes in Plant Simulation 14.2

• We changed the behavior of Plant Simulation when using the Pull control. The active MU (@) now
designates the part (MU). When unblocking the value is void.

• We significantly improved the performance of Plant Simulation when importing MS Excel files.
Importing is now several hundred times faster than before. To do so, we import the raw values from
Excel and convert the data in Plant Simulation itself. When importing date into columns of data type
string we convert numerical values in Plant Simulation itself. The Plant Simulation format might not
match the format that was set in Excel.

Important Changes in Plant Simulation 14.1

• We minimally improved the accuracy when calculating the CheckMUDistance event. This can affect
the simulation results, for example throughput and relative occupancy and when other events exist
which occur at the same time but when it counts which of these events is processed first.

• We minimally improved the accuracy when calculating the Bump event. This can affect the simulation
results, when other events exist which occur at the same time and when it counts which of these
events is processed first.

Back to What’s New in Tecnomatix Plant Simulation 15

New Features of the Material Flow Objects

Tecnomatix Plant Simulation 15 provides a number of new features.

New Features in Plant Simulation 15.0

• To facilitate cost analysis with the CostAnalyzer  , we added the tab Costs to the material flow

objects and the tab Costs to the Part and to the Container.

• We added the setting Workpiece carrier to the Container. You can use it to model the carrier on
which the part is transported from processing station to processing station in your facility. Statistics
then does not collect the values for the carrier, but for the transported part. In previous versions this
was cumbersome to achieve. This setting also affects routing the parts.

New Features of the Material Flow Objects
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• We added the Tabs menu to the material flow objects. If you hide tabs that you do not need, Plant
Simulation opens the dialog faster and you can change to those tabs faster that you need in your
daily work

• We added the check box Booking point to the settings of the Sensors. It sets that the booking point
of the part triggers the sensor.
We also changed the dialog of the Sensors in this context, and we added the attribute BookPosition,
the event SensorBookPos to the event list and the optional parameter BookPos to the sensor
control.

• We added the menu command Random Seed Value to the Tools menu of the material flow objects
and the fluid objects, which can create random numbers. To change the random seed value, select
the command and type in another value into the dialog.

• We added the read-only attribute CurrentDestinationAngle to the Turntable.

• We made the read-only attributes FrontLocation and RearLocation of the MUs observable.

New Features in Plant Simulation 14.2

• We added the tab Routing to the Part and the Container. These automatically find their destination
moving on Conveyors.
We added the menu command Route to Destination to the Part and the Container.

• We added the attribute DestinationWasReached to the moving objects.

• We added the check box Automatic processing to the objects Station, ParallelStation,
AssemblyStation, DismantleStation, and Drain. It sets if these objects start processing an entering MU
immediately or not.

• We added the optional parameter PredecessorNumber to the method create of the MUs. It sets the
number of the predecessor when the MU does not entirely fit onto the length-oriented object.

• We added the optional parameter ConveyingDirection to the method insert of the MUs. It sets the
direction in which the MU will be inserted on the object.
You can also enter -1 as the position. Then the MU is inserted so that its booking point is located on
the position 0, or at the end of the object when the MU moves in reverse.

• We extended the method setDestination of the PickAndPlace Robot. You can now also specify a
sensor as the destination object, for example setDestination(Conveyor.sensorID(1)).
The Angles Table of the robot can now also contain a sensor on the Conveyor in the column Name,
for example Conveyor.sensorID(1). This is useful if you want to set several angles on the
Conveyor.

• We added the attribute Location to the sensors. You can use it to query the object on which the
sensor is located.
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• We changed the behavior of the method outIn. The instruction MyPart.outIn(-1) no longer
causes an error. The object determines the time until MU exits by means of its processing time.
Normally statistics does not count this time as processing time unless you specify true for the
optional parameter WorkOnFinishedPartAgain.

New Features in Plant Simulation 14.1

• We added the Strategy > Method at Converting Point to the Converter. We also replaced the
attribute ExitForNextEnteringMU with the attribute ExitForMU.

• We added the method getStackHeight to the Store, to the Container, and to the Transporter with
matrix loading space.

• We added the function Start processing when full to the ParallelStation. If you clear the check box,
the ParallelStation behaves like it did in previous versions.

• We added the settings Relative from end and Length from end to the settings for creating a new
sensor.

• We added the read-only attribute ResCurrentState to the material flow objects.

• We added the check box Stopped to the MUs. In previous version you could only stop MUs with the
attribute Stopped.

• We added the statistics value Exit blocked to the tab Statistics of the Conveyor.

• We added the column ΔL to the Segments table. It shows the length of the length-oriented object up
to this segment.

Back to What’s New in Tecnomatix Plant Simulation 15

Changed Features of the Material Flow Objects

Tecnomatix Plant Simulation 15 provides a number of changed and improved features.

Changed Features in Plant Simulation 15.0

• We changed the default icon of the object Track. It now looks like this .

• We changed the behavior of the setting Start processing when full of the ParallelStation. If the
ParallelStation does not have to be set up, the ParallelStation can now also accept parts of different
types without starting processing them prematurely. For type-dependent and place-dependent
processing time or when you entered a formula as the processing time, the parts can then have
different processing times.

Changed Features of the Material Flow Objects
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• We made the attribute EntranceFree observable. For a ParallelStation with activated setting Start
processing when full the attribute EntranceFree now returns false if not all of the processed parts
have exited the station.

• We changed the behavior of the Transporter: In previous versions Plant Simulation reset an existing
TargetPosition or TargetDistance respectively when Transporters collided and showed an error
message.
From this version on TargetPosition/TargetDistance are retained and the Transporter drives to them
with the Speed/ Acceleration which the Transporter has with which the second Transporter collided.
If is impossible to reach the TargetPosition/TargetDistance because the first Transporter with which
the second Transporter collided, stops before that, TargetPosition/TargetDistance is retained as well.
As soon as the first Transporter starts driving again, the second Transporter tries to arrive at the
TargetPosition/TargetDistance.

• We changed the behavior of the Transporter: When you set the TargetPosition, for which the
direction would have to be changed, for a non-stopped Transporter with activated acceleration in an
exit control, Plant Simulation now shows an error message as there is no room for breaking until it's
time to turn around.

• We changed the behavior of the Buffer if MUs have several Out events because you set this with the
method outIn. In previous versions Plant Simulation computed a new Out event for the next MU and
overwrote the event that you created with the method when the first MU exited the Buffer. From this
version on Plant Simulation only computes an Out event for the next event if the MU does not have
an Out event yet.

• We added the optional parameters DropPosition and DropLane to the Drag-and-drop control of the
length-oriented objects. They designate the position at which the object is dropped and the lane on a
TwoLaneTrack.

• We added the optional parameter IgnoreRouteWeightingAttr to the method getRouteLength of the
Part/Container and the method getRouteLength of the Transporter. The parameter sets if the route
weighting attribute will be ignored (true) or if it will be used (false).

• We changed the data type of the attribute AxesOrigin of the Frame. In previous versions it was a two-
dimensional array of data type real with two values (real[2]). From this version on it is a two-
dimensional array of data type integer with two values (integer[2]).

Changed Features in Plant Simulation 14.2

• We moved the settings for the Exit strategy > Carry part away from the tab Exit to the sub-tab
Transport of the Importer. The settings on this tab replace the Exit strategy > Carry part away.

• We extended the function Start processing when full to the ParallelStation. Here you can now also
select the setting Recovery time starts > When processing is done for the start of the Recovery
time. For the setting When part exits the recovery time starts when the last part exits the station.
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• We reduced the default processing time of the objects Station, ParallelStation, AssemblyStation, and
DismantleStation from 1 (1:00) minute to 10 seconds (0:10). The latter value is better suited for
demonstrating the flow of materials.

• We changed the behavior of Plant Simulation when you define failures using the availability and in
doing so enter bounds for the MTTR. Plant Simulation now normally also finds a distribution of the
duration of the failure if one of the bounds is located closer to the MTTR as supported in previous
versions.
If one of the bounds is located very close to the MTTR, the program cannot determine a meaningful
distribution. If this is the case, please increase the distance of the bound to the MTTR.
The new algorithm also more accurately computes the distribution of the mean time between failures
(MTBF). For this reason the simulation results might slight deviate from the simulation results of
previous versions.

• We corrected the behavior of the TurnPlate, the TurnTable, and the AngularConverter. You now
cannot accidentally set the internal attribute Backwards via SimTalk any more.

• We extended the behavior of the method setRoute of the Part/Container and the method setRoute of
the Transporter. You can now also specify the objects along the route in an array of data type object.

• We extended the behavior of the method getRouteLength of the Part/Container and the method
getRouteLength of the Transporter. The MUs can now also write the objects along the route to an
array of data type object.

• We no longer support the method getRouteToDestination. Instead, you can use the method getRoute
of the Part/Container and getRoute of the Transporter.

• We changed the data type of the Width of the Connector from integer to real. For 3D models you can
now reduce the default width, which corresponds to 0 or 1, with values between 0 and 1, to a
fraction of that.

• We changed the name of the attribute Ctrl of the sensor control to Control.

• We added the return value of data type boolean to the read-only attribute StatWaitingTimeTable of
the AssemblyStation. As it only collects statistics values for the settings MU Types and Depends on
Main MU, the return value for the remaining settings is false.

Changed Features in Plant Simulation 14.1

• We replaced the attribute ExitForNextEnteringMU with the attribute ExitForMU.

• We do not support the method init of the EventController any more.

• We changed the behavior of Plant Simulation when an MU enters or leaves the loading space of type
Track or Line. As it is no longer rotated by 90 degrees, the orientation of the MUs now depends on
the orientation of the animation line in 2D and in 3D.

Changed Features of the Material Flow Objects
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• We changed the behavior of Plant Simulation. The first parameter of the method setDestination of
the pick-and-place-robot can now also be an MU or a storage place on an MU.

Back to What’s New in Tecnomatix Plant Simulation 15

New and Changed Features of the Fluid Objects

Tecnomatix Plant Simulation 15 provides a number of new and improved features.

New and Changed Features in Plant Simulation 15.0

• We added the methods addContent and setCurrentContent to the Mixer.

• We changed the behavior of the method setCurrentContent of the Tank. You can now also set a new
material when the Tank is not empty.

New and Changed Features in Plant Simulation 14.2

We added the read-only attribute ResCurrentState to the fluid objects.

Back to What’s New in Tecnomatix Plant Simulation 15

New and Changed Features of the Resource Objects

Tecnomatix Plant Simulation 15 provides a number of new and improved features.

New and Changed Features in Plant Simulation 15.0

• We added the object AGVPool to the Resource Objects. You can use it to create automated guided
vehicles for your installation that are not bound to a fixed route network.

• We added the object Marker to the Resource Objects. You can use it to set waypoints along which the
AGVs drive from the AGVPool to its destination.

Note:

In the current version the SankeyDiagram does not record the AGV, that is not bound to a fixed
route network.

• We change the call sequence of controls of the Exporter and of the Worker. In previous versions it
could happen that the Order control was executed before the Release control of the Exporter or that
the Order control was executed before the Release control of the Worker when moving an MU. In
this context the call sequence of the Entrance control and of the Order control changed as well.
From this version on the Entrance control is executed before the Order control.
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New and Changed Features in Plant Simulation 14.2

• We changed the behavior of the Worker. All Workers now stop during a failure.

• We added the attributes AdditionalServices, Amount, Efficiency, Shift, Speed and Worker to the
WorkerPool.

Back to What’s New in Tecnomatix Plant Simulation 15

New and Changed Features in Plant Simulation 14.1

• We replaced the text box Capacity of the Worker with the text boxes X-dimension, Y-dimension, and
Z-dimension. This now allows you to use an animation area for the Worker in 3D.

• We changed the behavior of the Exporter/Worker. When you turn on automatic mediation of the
Worker with the attribute AutomaticMediation, Plant Simulation now immediately tries to broker the
Exporter/Worker when the Broker has open requests.

Back to What’s New in Tecnomatix Plant Simulation 15

New Features of the Information Flow Objects

Tecnomatix Plant Simulation 15 provides a number of new features.

New Features in Plant Simulation 15.0

• We added the command Manage Breakpoints to the Method Editor. We also added the commands
Breakpoint Active and Breakpoint Settings to the Method Debugger.

• We added a key combination to delete all breakpoints, including those in the EventDebugger: To do
so, hold down the Shift key while you click Delete all Breakpoints.

• We added the command Open Debugger to the context menu of the Method in the Frame.

• We extended the behavior of the AttributExplorer. It can now also read the attributes
Coordinate3D.X, Coordinate3D.Y, and Coordinate3D.Z.

• We added the setting Simulation mode to the object PLCSIM_Advanced. You can use it to execute
data exchange with the PLC in real-time or stepwise.

• We added the method getColumn to the object SQLite.

New Features in Plant Simulation 14.2

• We added the tab Filter to the PLCSIM_Advanced Interface.

New Features of the Information Flow Objects
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• We added the attribute HasInitValue to the Variable.

• We added the optional parameter WithIndexes to the method copyFormatTo of lists and tables.

• We show the exact value with 17 floating point digits on the context menu of the tab Variables of the
Method Debugger for local variables of data type real, length, weight, speed, and acceleration.

New Features in Plant Simulation 14.1

• We extended the functionality of the Method Editor. When you select text with keyboard keys (Shift
key+arrow keys) or with the mouse pointer, Plant Simulation highlights all occurrences of the text
fragments in the Method in color, compare Find. You can then jump to these occurrences via the
ribbon like you would to any other bookmark or by pressing the F2 key.

• We added the button for inserting instance breakpoints to the Method Debugger. We also removed
the buttons for Searching and for showing the line numbers.

• We added the command Step into Encrypted Methods to the Method Debugger.

• We added the method writeExcelXMLFile to the lists and tables.

Back to What’s New in Tecnomatix Plant Simulation 15

Changed Features of the Information Flow Objects

Tecnomatix Plant Simulation 15 provides a number of changed and improved features.

Changed Features in Plant Simulation 15.0

• We changed how pre-formatted methods are created. Previously these were created with
SimTalk-1.0-syntax if New Syntax was deactivated in the class of the Method in the folder
InformationFlow. From now on pre-formatted methods are always going to be created with
SimTalk-2.0-syntax.

• We changed the behavior of the methods executeIn and executeNewCallChain of the object
Method and of user-defined attributes of data type method. In the called Method the anonymous
identifier ? now references the caller, i.e., the Method which contained the methods executeIn or
executeNewCallChain, or if the caller is a user-defined attribute of data type method it references the
location of this user-defined attribute.
In previous versions the anonymous identifier ? referenced the EventController for executeIn. For
executeNewCallChain the anonymous identifier ? was VOID in previous versions.

• We changed the behavior of the AttributeExplorer. The results table is now sorted according to path,
name, or label. As in previous versions, the AttributeExplorer first shows the data of the objects you
specified and then the data that is defined by the query.
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In previous versions the order in which the results were shown was determined by the sequence in
which you inserted the objects into you model. This was not reproducible afterwards any more.

• We changed the behavior of the DataTable. When you create a new model the setting Column index
belongs to contents is deactivated by default. For new models the column index belongs to the
format and will thus be inherited when you deactivate inheritance of the contents.

• We enhanced the functionality of the methods writeFile and writeObjectFile of the DataLists and
DataTables. For these you can now also enter System as equivalent to ANSI for the optional
parameter CodePage.

• We added optional parameters to the method step of the object SQLite.

• We added a return value to the method executeStatement of the object SQLite.

• We deleted the setting for the Allocated memory from the dialog Text File Format.

• We removed the command Tools > View > Tooltip Includes Type Info from the Method-Editor. The
command Show Tooltip with Completion now always shows the type information.

• We do not support the read-only attribute InheritsProgram of the Method any more. Instead you can
use generic access with the attribute getAttribute.

var bInherit:boolean
getAttribute("Program", bInherit)
print bInherit

Changed Features in Plant Simulation 14.2

• We changed the names of the information flow objects below. Now the names of the list objects
match the names of the data types.

Up to Version 14.1 From Version 14.2 on Data Type

TableFile DataTable table

CardFile DataList list

StackFile DataStack stack

QueueFile DataQueue queue

• We changed the behavior of the Method Debugger. When the Method Debugger was opened
because of a runtime error and when you then close it, Plant Simulation now terminates all call chains
without asking and stops the simulation.
If you only want to terminate the incorrect call chain and continue the simulation, press the F5 key
instead of closing the Method Debugger.
If you do not want to terminate the incorrect call chain, you can continue the incorrect Method in a
certain line of code by calling the context menu command Set Next Statement, or by placing the
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input cursor into this line and by pressing Ctrl+F10, or by holding down the Ctrl key and double-
clicking this line. Then press the F5 key to continue executing the Method in this line.

• We renamed the method methCall of the Method to executeIn.
We renamed the method newCallChain of the Method to executeNewCallChain.

• We extended the behavior when checking in a model in Teamcenter. You can now select if you want
to create a new revision.

• We improved the behavior of the Teamcenter interface. You can now specify the environment
instead of the server in the dialog of the object Teamcenter and in the Teamcenter Login Dialog.
You can select the Environment from the list of the environments configured in the TCCS, provided
environments are configured there. We also added the command Change Environment or Server to
File > Teamcenter in which you can change the settings later on.
The Teamcenter interface now also supports logging in to Teamcenter via Single-Sign-On (SSO). To do
so, you have to select the TCCS environment in which the settings of the SSO-Server are configured.
When logging in via SSO, you do not have to enter the user name and the password.
We support logging in via SSO in the login dialog to Teamcenter as well as in the dialog of the Plant
Simulation object Teamcenter.

• We changed the return value of the methods max, min, sum, maxAttr, minAttr, and sumAttr of lists
and tables.

• If the designated list range has a uniform data type, the return value now also has this data type.

• If the data type is not uniform, the return values are converted to the data type real and the
method returns the data type real.

• We extended the functionality of the PLCSIM Advanced interface. You can also allocate signals in the
Input/Output/Marker range via their address. This is useful if you want to access memory in the virtual
PLC for which no identifiers were assigned in the PLC program.
Open an existing group by double-clicking it. Or create a new group, click Apply, and then double-
click the new group. Enter a percentage sign followed by a character that sets the range, and the
address as the identifier. Compare these examples:

• %I100 for an Input signal at address 100

• %Q40.7 or %O40.7 for an Output signal at bit 7 of address 40

• %M5 for a Marker signal at address 5

Changed Features in Plant Simulation 14.1

• We changed the behavior of the Step Into mode of the Method Debugger: In previous versions this
mode also jumped into encrypted methods. From this version on this is not the case any more. When
the next instruction is the call of an encrypted Method, the command Step Into instead behaves like
the command Step Over.
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• We changed the behavior of the object Variable. When you clear Show units, Plant Simulation does
not show the distribution parameters any more.

• We changed how Plant Simulation sorts table columns of data type object: In previous versions empty
rows were sorted like the string VOID. From now on empty cells are sorted at the end of the column
for ascending sorting; they are sorted at the start of the column for descending sorting (sort,
inOrder).

• We do not support the method increment of the TableFile any more. You can use the += operator
instead, for example

TableFile[x,y] += 1

instead of

TableFile.increment(x,y)

Back to What’s New in Tecnomatix Plant Simulation 15

New and Changed Features of the User Interface Objects

Tecnomatix Plant Simulation 15 provides a number of new and improved features.

New and Changed Features in Plant Simulation 15.0

• We added the object CostAnalyzer  .

To facilitate cost analysis, we also added the tab Costs to the material flow objects and the tab Costs
to the Part and to the Container.

• We added the check box Inheritance box to the command New Check Box of the object Dialog.

• We enhanced the behavior of the setting Display in Frame of the Chart. It now provides the setting
3D image quality provided 3D is activated.

• We changed the behavior of the HtmlReport.
It now sorts according to the object names. Let's say that you show a table with statistics data of all
objects in the current Frame with the instruction [current, %States]. The report then sorts the
object order according to the object names.
If you show all Drains with the instruction [.MaterialFlow.Drain*], the report sorts the order of
the Drains according to their names.

• We changed the behavior of the HtmlReport for collecting and displaying object instances, compare
Collect Object Instances and Show Them in the Report.

• We added the GanttChart to the objects which the HtmlReport, compare Display a GanttChart.

New and Changed Features of the User Interface Objects
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• We added these methods to the GanttChart.

• exportChart

• getLanes and setLanes

• We added these attributes to the GanttChart.

• EnableVisualTracking

• NumVisibleBars

• ShowBarText

• ShowPartView

• ShowResourceStates

• The method getData now does not return any intermediate resource states any more, which do
not use up any time.

• We added the method getPartFlowData to the SankeyDiagram.

New and Changed Features in Plant Simulation 14.2

• We renamed the object WorkerSankeyDiagram to SankeyDiagram. It replaces the object
SankeyDiagram, which previous versions provided in the Toolbox under Tools. The SankeyDiagram
can display Sankey flows of parts as well as Sankey flows of Workers, who walk freely within the area
or walk on FootPaths.

• We changed the behavior of the Dialog. In previous versions the Dialog was closed when the
focus/the mouse was located in a dialog item of type New Edit Text Box and when you pressed the
Enter key. In this case the Dialog interpreted pressing the Enter key as being identical to clicking OK.
When the standard buttons OK, Cancel, Apply are shown, the Dialog will not be closed any longer
when the Enter key is pressed.
If the edit text box has a Callback argument, now the Callback Method of the Dialog will be called
and the Callback Method is assigned the callback argument _Enter.

New and Changed Features in Plant Simulation 14.1

• We added the object GanttChart. It replaces the GanttChart and the GanttWizard that previous
versions of Plant Simulation provided. The GanttChart visualizes parts on resources.
This affects the GanttWizard and the object GanttChart as follows:

• If you are using the GanttWizard, you just have to update it under Manage Class Library.
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• If you are using the GanttChart of previous versions, you have to:

■ Replace the GanttChart with the GanttChart of the current version.

■ Adjust the source code, which you programmed in SimTalk of previous versions, to the current
version, compare Methods of the GanttChart and Attributes of the GanttChart.

• We added the methods getAnnotations and setAnnotations to the Chart. They replace the attribute
Annotations.

• We added the read-only attributes GetAverage and GetStandardDeviation to the object Display.

• We enhanced the functions that Plant Simulation executes when you click Select an Object or an
Object Attribute to be Displayed on the HTML Page in the HtmlReport.
The dialog Object Parameters now recognizes statistics types and shows the respective column
parameters. For objects, which record statistics values, the HtmlReport now also shows the columns
and you can enter which columns you want to show.

Back to What’s New in Tecnomatix Plant Simulation 15

New and Changed SimTalk Features

Tecnomatix Plant Simulation 15 provides a number of new and improved features.

New and Changed Features in Plant Simulation 15.0

• We added the method asObject to the arrays.

• We added the methods appendValueOfType and getValueOfType for arrays of data type integer.

• We added the method join to the arrays.

• We added the method pop to the arrays.

• We changed how Plant Simulation displays empty arrays. These are now displayed with an empty
space between the brackets, like this "[ ]". In previous versions they were displayed without the
empty space like this "[]".
This also affects the global function to_str:

var a : real[]
var s : string := to_str(a)  -- s := "[ ]" 

• We changed the behavior of the equal operator and of the not equal operator for arrays.
In previous versions the equal operator always computed the value false if the data types of the array
were different. Suppose that an array of data type real was compared to an array of data type length,
Plant Simulation always computed false, even if the values were identical.

New and Changed SimTalk Features
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If an array of data type any was compared with an array that did not have the data type any, the
result was always false as well.
From version 15 on this behavior applies:
When comparing arrays of different data types, Plant Simulation creates a runtime error and opens
the Method Debugger in the following cases:

• Arrays of data type real, length, time, speed, and weight based on their content.

• Arrays of data type any are compared to other arrays based on their content as well.

Arrays of data type integer cannot be compared with arrays of data type real, length, time, speed, or
weight.

• We changed the behavior of the function throwRuntimeError: In case the method does not run as a
subroutine, i.e., when no caller exists, Plant Simulation opens the Method debugger at the position
which contains the function throwRuntimeError. If the method is encrypted, Plant Simulation opens a
message box instead that shows the message.

• We extended the upper bound of the parameter Lambda of the Poisson-distribution from 700 to
unlimited. The value of the parameter Lambda has to be greater than 0 though.

• We changed the names of the distribution parameters of the Uniform distribution: In previous
versions they were called Start and Stop. From this version on they are called Lower Bound and
Upper Bound.

New and Changed Features in Plant Simulation 14.2

• We added the method contains to the arrays.

• We added the read-only attribute Magnitude to the arrays.

• We added these functions to check if a string has a valid date/time format: isValidDateString,
isValidDateTimeString, and isValidTimeString.

• We added the function datetime_to_str.

• We extended the global functions min and max, compare Functions for Numerical Values:

• You can now also pass more than two parameters to both functions.

• Both functions can now handle additional data types. In addition to numerical values (integer, real,
length, weight, speed, acceleration) the functions now also process parameters of data type date
and dateTime as well as parameters of data type string. You cannot mix data types arbitrarily
though, i.e., all data types either have to numerical, or all data types have to be of data type date
and dateTime, or all have to be of data type string.
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• We changed the behavior of the method connectAutomatically. It now does not return false any
more when you try to connect a class. Instead, the program opens the debugger.

• We changed the return values of the method getSimTalkTypename. It now returns for the data types
table/stack/queue instead of list these strings:

Data Type Up until version 14.1 From version 14.2 on

table list table

stack list stack

queue list queue

For local variables of data type any, which were assigned a special object, for example a sensor, the
return value now is not of data type object more, as such a special object cannot be assigned to a
local variable of data type object. Instead getSimTalkTypename now returns sensor, lane,, storage
place, 3D object, or 3D animation depending on the type of the special object.

• We changed the behavior of switch instruction for values of data type real. These no longer check for
exact equivalence.

• We changed the behavior of print instructions for values of data type length, weight, speed, and
acceleration. These now show the unit after the value in the Console.

New and Changed Features in Plant Simulation 14.1

• We changed how to enter arrays in SimTalk 2.0 Methods. Up until now you had to use the function
makeArray. Now you can enter arrays directly into the source code:

var a : real[3]
a := [1.4142, pi, sin(0.5)+1]

This makes it easier to enter an array and it also makes your source code considerably shorter.

• We changed how you enter lengths into SimTalk 2.0 source code. Now you can also specify the
Length with a physical unit. You can enter one of these units: m, mm, km, cm, yd, ft, and in.

var len := 1.0ft
var len := 1.0ft
var s : speed := 10.5m / 1:30

• We added an optional parameter to the function num_to_hex, with which you can set if Plant
Simulation creates a 64-bit hexadecimal number.

• We added the function throwRuntimeError.

• We added the function enableFullScreenMode.

New and Changed SimTalk Features
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Back to What’s New in Tecnomatix Plant Simulation 15

New 3D Features

Tecnomatix Plant Simulation 15 provides a number of new features.

New Features in Plant Simulation 15.0

• We introduced navigating with a 3D mouse in the Planning View. Moving on the plane corresponds
to moving the view, just like dragging with the right mouse button with a 3-button-mouse. Pulling the
puck up zooms in, pushing it down zooms out.

• We added the command Optimize Model to the Home Ribbon Tab.

• We added the command Show Sky to the View Ribbon Tab in 3D.

• We added the subcommand Mezzanine to the command Insert Shape.

• We added the submenu Transformation Inheritance to the Context Menu for Several Selected
Objects.

• We added Optimization settings to the dialog Import Graphics.

• We added the check box Start at first tread to the object Stairs. Select it to make the stairway start at
the first tread without the stringer extending onto the floor on which the stairway rests.

• We added the settings Bounding box of visible graphics and Visible graphics to the Obstacle for
the Worker.

• We added the number of obstacles and the number of the resulting corner points to the dialog
Show Obstacles. The number of obstacles and vertices affects the computation of the shortest
route.

• We added attributes, read-only attributes and methods of 3D Shapes.

• We added attributes for the material of graphics, compare Detailed Access To Graphics.

• We matched the behavior of Connectors in 3D with their behavior in 2D, meaning you can now also
insert anchor points.

• The subcommand Inherit Positions of the command Transformation Inheritance now also
activates inheritance of the anchor points of the Connectors.

• You can now also edit the anchor points of the Connectors with the position manipulator. If you did
not select anything in the scene, the command Show Manipulators also shows the position
manipulator of the Connectors in the scene if Connectors are shown in the scene.
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• We added the attribute _3D.getAttribute.

• We added the read-only attribute _3D.getWorldCoordinate.

• We added the optional parameter Offset to the method _3D.getPositionOfObject.

• We added two optional parameters to the method createCuboid. You can use them to add a colored
line around the created cuboid.

Back to What’s New in Tecnomatix Plant Simulation 15

New Features in Plant Simulation 14.2

• We added the tab Poses. Together with the joints you can define joint kinematics.
We added Methods for Poses for objects which you can insert into a Frame, and for MUs.

• We added the tab Joint. Here you can define the settings for rotating and translating the animation
joints of the animation objects. In this context we moved the settings for the rotation axis and the
rotation center of the animatable objects from the tab Self Animation to this tab.

• We added the read-only attribute _3D.ExistsWithAnimation.

• We added the attribute _3D.AniTranslationDirection.

Back to What’s New in Tecnomatix Plant Simulation 15

New Features in Plant Simulation 14.1

• We added the conveyor type > Guide-railed belt conveyor.

• We added a number of new extrusion profiles for the conveyor type > User-defined.

• We enhanced the configuration options of the conveyors considerably and we changed the leg
types.

• We added the tab States to the 3D Properties of the objects. In doing so, we moved the respective
settings from the tab Graphics to the tab States.

• We added the animation area to the tab MU Animation of the PlaceBuffer in 3D.

• We added the setting Wall thickness to the dialog Insert Box.

• We added the buttons Show Manipulators and Hide Manipulators for most objects to the Edit
ribbon tab. During this process we removed the context menu command Segments > Show
Segments for the length-oriented objects and the command Show Corner Points from the context
menu of the Connector.

New 3D Features
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• We added settings for positioning the imported graphic to the dialog Import Graphics.

• We added the context menu for several selected objects.

• We added the commands Show, Paste, and Remove Texture to the context menu of a graphic
node.

• We added the methods _3D.MUAnimations.AnimationPathName.getPositionAt and
_3D.MUAnimations.AnimationPathName.Length for saved MU animations.

Back to What’s New in Tecnomatix Plant Simulation 15

Changed 3D Features

Tecnomatix Plant Simulation 15 provides a number of changed and improved features.

Changed Features in Plant Simulation 15.0

• We simplified the SimTalk access to 3D Shapes and graphics, compare Detailed Access To Graphics.
Among others, we replaced access via methods with access via a number of individual attributes.
We also added a number of new attributes and methods.

• We changed the look of the Planning View:

• We now show the background of the Frame without a color gradient and white by default. This is
not the case if you set a color of its own for the opened Frame or the folder.

• We now always show the grid, independent of the grid settings, without a base plate.

• We changed the behavior of 3D only models:
In 3D only models the positions and rotations between 2D and 3D are now always synchronized. In
the past you could not deactivate the connection between positions and rotations between 2D and
3D. It was still possible though via SimTalk and existing models retained their state concerning their
existing connection between position and rotation connections when switching the model type to 3D
only.
The new behavior has the following effects:

• When loading models created in previous versions, positions, rotations, and anchor points of
length-oriented objects are force-synchronized based on the data from 3D.

• The same happens when switching the model type to 3D only.

• SimTalk access to the attributes _3D.RotationsConnected and _3D.PositionsConnected do not
cause an error in the Debugger. The assignment is ignored though and Plant Simulation now
always returns a constant value when querying it. For positions the return value always is true and
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for rotations it is true in most cases, depending on the object type. In some special cases, for
example for the Variable, the return value is false.

• We changed the behavior when you select MU instances and Worker instances. Plant Simulation now
does not select these per window in 3D any more, but in general. In most cases this does not have
any direct visible effects.
You can see the difference though when more than one 3D window is open and these 3D windows
show the same Frame or different parts of the same Frame. An instance then counts as being
selected in a window when in it is selected in 3D and is also visible in this window. As opposed to
previous versions you can now also select an MU in one window and deselect it in another window.

• We changed the behavior when Lock Structure is activated. When you hold down the Alt key, Plant
Simulation selects the objects which you click. When you do not hold down the Alt key, Plant
Simulation selects the Frame instances that are inserted in the model.

• We changed the behavior, when you create a new animatable object from a graphic for an object with
matrix loading space Transporter and Buffer. Then Plant Simulation creates the MU animation area
by means of the physical size of the created animatable object.

• We changed the number of 3D windows that you can open interactively. In previous versions you
could open 32 3D windows, from version 15 on you can only open 30.

• We terminated support of the methods _3D.MUAnimations.Animation.cancelRedirection,
_3D.MUAnimations.Animation.isRedirected, and _3D.MUAnimations.Animation.redirectTo any more.
We recommend to use the attribute _3D.AnimationObject with additional animatable objects
instead.

• We changed the display of 3D graphics: If 3D graphics are hidden because of the values you set for
the Screen coverage threshold, the entire numeral display is now treated as an indivisible graphic,
meaning that Plant Simulation either shows the entire number or nothing at all. In previous versions
each number was treated individually, which, for example, lead to the decimal point being hidden.
When you select OpenGL 4.3 or higher and have a graphics card that is suited for this, Plant
Simulation now uses a different mode for processing stacked transparencies, for example half-
transparent window in front of another half-transparent window.

• We changed the behavior of the commands Make Animatable Object and Make Simulation Object:
If the command Lock Structure is active for one of the concerned Frames, these commands will not
be executed when you called them in a view.

• We changed the behavior when importing graphics, which are to consist of several files. When Plant
Simulation now does not find a reference to a file, it cancels the entire graphics import with an error
message.

• We changed the looks of the legs of store graphics of type > Floorspace. These now always are
square. This can lead to changed simulation results in models in which Workers walk below the Store
and for which you selected Obstacle for the Worker > Graphics.

• We changed the behavior of the Rack. Its frame does not create a worker obstacle any more.

Changed 3D Features
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• We changed and enhanced the settings of the command Optimize Selected Graphic.

• We enhanced the behavior of the command Move to Zero. It now also apples to JtTriStripSets. These
are graphics nodes, which do not have any child nodes and oftentimes consist of imported graphics.

• We enhanced the behavior of the command Show Manipulators. You can now also display them for
Frames. We also combined the commands Show Manipulators and Hide Manipulators to a single
command.

• We changed the behavior of the attribute _3D.Dimensions. You cannot assign negative dimensions
to a Store any more.

• We enhanced the behavior of the mouse wheel in the Pose Editor. You can now also use the mouse
wheel when entering the upper limit or the lower limit for the joint on the tab Poses.

• We changed the behavior when editing poses. These are not shown orange any more.

• We enhanced the behavior of the edddison interface. When you define a bounding box, you can now
also set its Name and its Height.

Changed Features in Plant Simulation 14.2

• We improved the behavior of the setting Transparent of the objects Display, Comment, and Variable
in 3D. These now allow the background of the Frame to shine through, just as the objects do in 2D,
when you activate the check box.

• We changed the behavior for automatically connecting length-oriented objects which transport parts.
Plant Simulation now also considers this exception in 3D for the objects Turnplate, Turntable,
AngularConverter, Conveyor, Track, Converter, and TwoLaneTrack: When Transfer length is
deactivated for one of these objects in 3D, but when a suitable MU animation path exists, then Plant
Simulation uses the start and the end point of this animation path for automatically connecting
objects and for depicting the Connectors. Suitable MU animation paths are Default or Cross for the
Converter, A or B for the TwoLaneTrack, and Default for all other objects. This applies to the setting
Connect objects automatically and for the method connectAutomatically.

• We changed the looks of the manipulators of the length-oriented objects to improve usability,
compare Show Manipulators.

• We changed the behavior of manipulators for factory walls and for the fence. You can now also set
one of the dimensions to 0 by dragging the respective manipulator.

• We changed the looks of the cross hairs when you use the command Make Animatable Object. The
cross hairs is now drawn in the maximum contrast color to the background color and is twice as thick
starting from a certain distance from the object itself.

• We changed the identifiers Extrusion path and Extrusion profile to Extrusion configuration.
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• We changed how 3D shows the individual lines in the WorkerSankeyDiagram. These are now
terminated with semi-circles to make the transition between lines look better.

• We changed how to play translations and rotations. In previous versions you had to specify
<Path>_3D.SelfAnimations.playTranslation and <Path>_3D.SelfAnimations.playRotation. Now you
can also type <Path>_3D.playTranslation and <Path>_3D.playRotation.

• We changed the behavior of the attribute _3D.ShowContent or _3D.getObject(...).ShowContent
respectively. It now only applies to objects, which can transport MUs, and for the Frame.

• We changed the behavior of the dialog Grid Position and Orientation. When you close it, grid
position and grid orientation will now be reset.

• We changed the behavior when exporting 3D scenes, for example with the command Export Bitmap,
for adding the picture to a HTMLReport or for printing. The picture of the 3D scene is now created
with the best possible quality, i.e., the screen coverage threshold is ignored here.

• We renamed the attributes _3D.SelfAnimations.EstimatedBlockAnimationTime and
_3D.SelfAnimations.EstimatedTotalAnimationTime to _3D.SelfAnimations.AnimationTimeBlock and
_3D.SelfAnimations.AnimationTimeTotal.

• We renamed the attributes _3D.CameraAnimations.EstimatedBlockAnimationTime and
_3D.CameraAnimations.EstimatedTotalAnimationTime to
_3D.CameraAnimations.AnimationTimeBlock and _3D.CameraAnimations.AnimationTimeTotal.

• We removed the command Insert Shape > Box. To create a flat plate, type in a very small value, for
example 0.01, for the respective dimension of the box.

• We terminated support of the attribute _3D.Location.

• We terminated support of the methods _3D.CameraAnimations.scheduleRotation,
_3D.CameraAnimations.scheduleTranslation, _3D.CameraAnimations.playRotation, and
_3D.CameraAnimations.playTranslation.

Changed Features in Plant Simulation 14.1

• We changed where Plant Simulation places an object:

• When you click an object with the mouse and then insert it on another object or a graphic.

• When you place objects with Drag and Drop, for example a part onto a Pick-and-Place-robot.

• When you create and insert a sensor with the mouse.

In previous versions Plant Simulation projected the mouse position onto the grid and used this
coordinate as the insertion or target position. From now on Plant Simulation uses the surface of the
object or the graphics over which the mouse is located as the insertion or target position.

Changed 3D Features
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• We changed how to create a non-textured plate. Just type in 0 into one of the text boxes in the dialog
Create Cube.

• We set the height of text, which you insert with Insert Shape > Create Text into your model to 1 cm.

• We changed how parts are animated on length-oriented objects. The length-oriented objects now
longer provide automatically generated animation paths on the tab MU Animation. Instead they now
animate the parts without using animation paths. This makes the enforced deactivation of the MU
animation for length-oriented objects redundant.

• We changed the behavior of Buffer and Sorter. Plant Simulation now shows the parts stacked in 3D
when these object only have a single animation point.

• We changed the behavior of the command Select All (Ctrl+A). It does not select path nodes and
manipulators any more.

• We changed the behavior in a 3D Only model. It does not show the check boxes Connect 2D and 3D
Positions and Connect 2D and 3D Rotations.

• We changed the behavior when inserting Connectors with the mouse. When you click on an Interface
of a sub-Frame while doing so, this Interface is now directly evaluated as the starting point or as the
target. When the Interface is allowed, it will be connected, when the Interface is not allowed, Plant
Simulation does not execute any action. When you click on any other part of the Frame, Plant
Simulation behaves as in previous versions, and opens the dialog Select Interface.

• We changed the return value of the method _3D.CameraAnimations.getAnimation.

• We do not support the graphic format PLMXML any more. From this version on, you cannot import
graphics in PLMXML format.

Back to What’s New in Tecnomatix Plant Simulation 15

Miscellany

Tecnomatix Plant Simulation 15 provides a number of new and improved features.

New and Changed Features in Plant Simulation 15.0

• We changed the behavior of the method move of the MUs. The destination of the MU is now only
deleted when the MU moves from the Worker to the destination.

• We changed looks of the Toolbox.

• We changed the looks of the Statistics Report. The data it shows is the same.
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1-58  , Plant Simulation 16.0
© 2020 Siemens



• We added the read-only attribute NumberOfLimitedObjects to the Frame. It counts the number of
objects which you can use in a Student License per used Frame.

• We changed the data that the Profiler shows:

• Instead of the total time for method execution it now shows the percentage.

• In addition we now also show the Total CPU time for 3D rendering and the Percentage for
worker path network computation.

• We changed the looks of the window Show Attributes and Methods. The column Inherited now
shows a ✔ for inherited attributes, methods, and read-only attributes and a - for not inherited
attributes, methods, and read-only attributes. In previous versions the column showed i for inherited
and ni for not inherited.
In addition you can now change inheritance of the value of an attribute by clicking the inheritance
toggle button of the value that you are editing.

Note:

This does not apply to the objects for the Genetic Algorithms.

Miscellany
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• We changed the behavior of the window Show Attributes and Methods. It now only shows the
column with the German names of the SimTalk functions when:
You are working on a computer that runs the German version of Windows.
You selected German as the model language of your simulation model.

• We removed the check box Tooltip includes type info from the tab Editor of the dialog File >
Preferences. The command Show Tooltip with Completion now always shows the type information.

• We added the optional parameter CanInherit to the attribute getAttribute. It returns if the value of
the attribute can be inherited or not.

• We added the Data Type of the Value You Can Assign to the Syntax description of the attributes.
We added the Data Type of the Return Value to the Syntax description of the read-only attributes.

New and Changed Features in Plant Simulation 14.2

• We changed the behavior when dragging and dropping an object to a text box, into Method or into a
DataTable: In previous versions Plant Simulation then entered the absolute path. From version 14.2
on it enters the relative path.

• Plant Simulation 14.2 and higher requires version 9 of the SPLM License Server.

• We extended the functionality of the command Import Bitmap File. The format DWG now also
supports AutoCAD 2018 files.

• We improved the behavior of Plant Simulation when you changed the size of text and other items
under Control Panel > All Control Panel Items > Display. This settin not only applies to the common
Windows user interface, but also for Frames in 2D. In doing so, Plant Simulation increases the size of
the Frame. If you select a values less than 150 %, Plant Simulation does not increase the size of the
contents of the Frame.
If you select different sizes of text and other items for different monitors, this does not affect Plant
Simulation. In this case Plant Simulation always uses the size set for the primary monitor. Your
changes will only take effect after you logged off and on again.

• We removed support of the method step of the EventController.

New and Changed Features in Plant Simulation 14.1

• We changed the initialization of random number streams. With the previous way of initializing them it
was possible that the first rolled number of a random number stream took similar values for different
random number variants of the EventController. Due to the changed random numbers the results of
short simulation runs can change.

• We added the buttons for controlling the simulation to the  Quick

Access Toolbar.
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• We added the command Stop on Controls in Object to the ribbon tab Debugger.

• We added the tab User-defined Attributes to these objects: FileInterface, FileLink, Comment,
SQLite Interface, and PLCSIM_Advanced Interface.

• We added the context menu command Revert all Objects to Standard Graphics to the Class Library.

• We enhanced the function Manage Class Library. The dialog now also shows deprecated libraries.

• We added the method hasAttribute for all objects.

• We added the function OpenConsoleLogFile to the COM Interface.

• We changed the behavior of the attribute Coordinate3D for MU instances in a 3D Only model. Now
you cannot query that value any more.

• We enhanced the behavior of the EventController. You can now activate and deactivate breakpoints in
the dialog window of the Event Debugger.

• We enhanced the functionality of the method setRequiredLicense.

• We changed the structure of the SimTalk Reference Help in the online help. It now consists of two
separate topics: General SimTalk Functions and 3D-related SimTalk Functions.

Back to What’s New in Tecnomatix Plant Simulation 15

What's New in Tecnomatix Plant Simulation 14

What's New in Tecnomatix Plant Simulation 14

Tecnomatix Plant Simulation 14 provides a number of new and improved features.

• Important Changes in Plant Simulation 14

• Simulation- and Animation-Relevant Changes

• New Features of the Material Flow Objects

• Changed Features of the Material Flow Objects

• New and Changed Features of the Fluid Objects

• New and Changed Features of the Resource Objects

• New Features of the Information Flow Objects

What's New in Tecnomatix Plant Simulation 14
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• Changed Features of the Information Flow Objects

• New and Changed Features of the User Interface Objects

• New and Changed SimTalk Features

• Miscellany

• New 3D Features

• Changed 3D Features

Back to What’s New

Important Changes in Plant Simulation 14

Tecnomatix Plant Simulation 14 provides a number of new and improved features.

Security

We added the setting File > Model Settings > General > Access to the computer is prohibited to
ensure that simulation models, which you receive from others, do not damage your computer.

• To facilitate this via SimTalk, we added the method isComputerAccessPermitted.

• To facilitate this via SimTalk, we added the method SetTrustModels to the COM interface.

• If you activate this security setting, this also affects a number of methods that can access your
computer.

• We added the start option -TrustModels. When you enter this start option, Plant Simulation treats
models, which you receive from others as if they were your own models. When you open a model
that your received from somebody else, for which the model setting permits access to the computer,
Plant Simulation does not notify you about this.
Models, which were saved with a version older than 14, do not receive a trust ID and thus are always
considered to be models from other people. Normally access to the computer is denied when loading
an old model into version 14. If you entered the start option -TrustModels, the old model
automatically has access to the computer.

• We added the setting Access to the computer is permitted to libraries.
We added another parameter to the method getLibraryInfo allowing you to query access to the
computer.

1. What's New
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Active Workspace in Teamcenter

We added Active Workspace for easier and more convenient access of Plant Simulation to the
Teamcenter database.

• You can use Active Workspace to add your Plant Simulation models to the Teamcenter database and
to later open them from the database.
With Active Workspace you can:

• Select the target folder of the model with the command File > Teamcenter > Add to Teamcenter.

• Select a model with the command File > Teamcenter > Open from Teamcenter.

• With Active Workspace in the Teamcenter Interface you can select Teamcenter objects via Active
Workspace and to further process these objects in Plant Simulation.
You can:

• Select an application interface object in the dialog of the Teamcenter Interface via Active
Workspace.

• Select the target folder of the Report in the dialog of the Teamcenter Interface via Active
Workspace.

Animation Area for Parts

We added settings for the animation area to the tab MU Animation of the objects with matrix loading
space. The animation area replaces the function Create Paths > Create Locations of previous versions
of Plant Simulation.

Important Changes in Plant Simulation 14
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Scale Parts Automatically

We replaced the setting Auto graphics active for the MUs with the setting Scale automatically. It
adjusts the size and the position of the graphic of the MUs to the dimension and the booking point of
the MU in 2D.

1. What's New
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Simulation- and Animation-Relevant Changes

We made changes that are relevant for the simulation and the animation in Tecnomatix Plant
Simulation 14. For this reason you have to adapt simulation models which you created in previous
versions of Tecnomatix Plant Simulation, when you open them in Tecnomatix Plant Simulation 14.

Simulation- and Animation-Relevant Changes in Plant Simulation 14.0

• We changed the behavior of the feature setup after n parts with the setting After last part. If you
entered a formula for the setup time, the anonymous identifier @ was void in previous versions when
the machine was set up after the n-th part. Now you can access the n-th part with @.

• We changed the behavior of the Store when it delivers mounting parts for an AssemblyStation and
when several parts in the Store are simultaneously unblocked for a main part. From this version on
the parts arrive in reversed order at the AssemblyStation.

• We changed the behavior of the read-only attribute CurrentSpeed of MUs on Conveyors.
CurrentSpeed now always has the sign (+ or -) of the respective direction of movement of the Line. In
previous versions the sign of the CurrentSpeed could differ from the direction of movement of the
Conveyor when the MU was conveyed by a Converter beforehand.

Simulation- and Animation-Relevant Changes
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• We changed the behavior of method initialize of the TableFile. If you tried to initialize the column
index, for example with TableFileFile.initialize({0,*}, "AA")), Plant Simulation did not
execute this and retained the previous values. Now Plant Simulation assigns the passed initial value.

• We changed the behavior of the attribute Coordinate3D: It now returns an array of data type length
instead of data type real as in previous versions.

Simulation- and Animation-Relevant Changes in Plant Simulation 13.2

• We changed the behavior of the SQLite Interface: When you open a file-based SQLite database, Plant
Simulation applies the following default settings, which deactivate transaction support:
PRAGMA locking_mode=EXCLUSIVE
PRAGMA journal_mode=NORMAL
PRAGMA synchronous=OFF
These settings considerably accelerate access to the database.
To get the SQLite default settings, which support transactions, you can use the following instructions:

SQLite.exec("PRAGMA locking_mode=NORMAL");
SQLite.exec("PRAGMA journal_mode=DELETE");
SQLite.exec("PRAGMA synchronous=FULL");

• We fixed non-expected behavior that occurred in the method find of lists and tables. When you
searched a table and then started a second search, for which you entered a range, which did not
contain the cell of the first search, the search was only started after the first cell of the new range, as
the search was continued.
Now we reset the search and the search then starts in the first cell of the range as if a call of the
method setCursor had been executed.

Simulation- and Animation-Relevant Changes in Plant Simulation 13.1

• When resetting the simulation model, Plant Simulation now does not call the Request control, the
Receive control, and the Release control of the Importer any more.
This is because the MUs are deleted when resetting the simulation model. This then triggered the
release control for example. Normally you can access the active MU with the anonymous identifier
@. As the active MU was deleted while resetting the model, the Debugger opened. For this reason
you had to program source code in your model that handled a case that never occurred during the
simulation.

• The new settings of the 3D-function MU side to attach caused the state of the setting to convert the
animation path to the new setting. A model, that relies on a certain inheritance state of the MU
Animation and then changes the state with SimTalk commands, might lead to a changed animation
for the object Pick-and-Place-Robot.

Back to What’s New in Tecnomatix Plant Simulation 14
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New Features of the Material Flow Objects

Tecnomatix Plant Simulation 14 provides a number of new features.

New Features in Plant Simulation 14.0

• We added the setting MU conveying direction to the tab Attributes of the Pick-And-Place-Robot.

• We added the Tab Importer to the Pick-And-Place-Robot. This way you can order a Worker for
repairing the services to remove the failure.

• We added the setting Off to the dropdown list Set-up depends on. It deactivates setting the object
up after changing the type to another MU. This means that the station will only be set-up after the
number of parts that you selected.

• We added the Z-dimension to the Store, the Container, and to the Transporter. This allows you to
stack parts on these objects.

• We added the attribute MUHeightWithContent to the MUs. You can use it when stacking parts.

• We added the setting Throughput per Minute to the tab Tab Type-dependent Statistics of the
Drain.

• We added a setting to the object Interface to show the number of the next aimed at exit on the tab
Exit when you already determined that exit.

New Features in Plant Simulation 13.2

• We added the setting Only for empty blocking list to the tab Attributes of the Pick-And-Place-Robot.

• We added the setting Target selection to the tab Exit of the Pick-And-Place-Robot.

• We added the Loading time and the Unloading time to the tab Attributes of the Pick-And-Place-
Robot.

• We added the method findFreePlace to the Store.

• We added the read-only attribute LocationInFrame to the MUs.

• We added the attribute TargetDistance to the Transporter.

• We added the command Delete Sensor to the context menu of length-oriented objects in the Frame.
To delete a sensor in 3D, press the Del key on the keyboard.

• We added the method getHTMLCode for all objects which can create a statistics table in the
HtmlReport.

New Features of the Material Flow Objects
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• The button  in the text box of the control on the tab Controls now provides these commands:

New Features in Plant Simulation 13.1

• We enhanced the functionality of the Source. For the setting Time of creation > Interval Adjustable
you can now also set the Amount of parts to be produced. When you do not set the Stop time, Plant
Simulation produces the amount of parts you entered at most.

• We added the setting Assembly table > Depends on Main MU to the AssemblyStation.

• We added the menu command Calculate Dimensions from 3D to the Tools menu of the MUs.

• We added the method getStoragePlace to the MUs. You can use it to find out on which storage place
within a Store the MU is located.

• We increased the number of Parameters which observer methods accept. You can declare observer
methods with one, two, or three parameters.

• We added the optional parameters Destination and Name to the methods derive and duplicate to
enable these methods to replace the method createObject. To create the object at a certain position
in the Frame as with the method createObject, use the attribute Coordinate3D.

• We replaced the method setUp with the method resSetUp.

Back to What’s New in Tecnomatix Plant Simulation 14

Changed Features of the Material Flow Objects

Tecnomatix Plant Simulation 14 provides a number of changed and improved features.
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Changed Features in Plant Simulation 14.0

• We changed how the function Fast Forward Simulation of the Eventcontroller works. It now
automatically deactivates Realtime mode. When you terminate Fast Forward Simulation, Realtime
mode will be activated again, provided it was activated before.
You can now quick and easy switch between Fast Forward Simulation and normal simulation by
clicking the respective button while the simulation is running.

• We changed the behavior when querying the contents list of a length-oriented object or of the
position list of an MU on a length-oriented object with the methods contentsList and positionList.
The values for the positions are not rounded any more.

Changed Features in Plant Simulation 13.2

• We extended the functionality of the method outIn. You can now also specify outIn(-1, true) for
fully processed parts.

• We changed the behavior when an object, on which a blocked MU is located, is failed/paused/
stopped: Now the MU is no longer removed from the blocking list when the MU you unsuccessfully
attempted to move it with one of the methods insert, move, or transfer before an Out event was
processed for this MU.

• We changed product statistics of the MUs: MUs, which are located in a blocking list, are now always
counted as waiting, no matter which state the material flow resource is in. MUs, which are loaded or
unloaded from a resource by a Pick-and-Place Robot, are always counted as working.

Changed Features in Plant Simulation 13.1

• We now enter root.Broker into the text box Broker by default into the sub-tabs of the Tab Importer.
For this reason Plant Simulation now does not show an error message any more when you click on
Apply. When Plant Simulation detects an invalid Broker during the simulation, it opens the dialog of
the object with the respective sub-tab.

• We changed the behavior of Plant Simulation. Now no events are calculated any more when
resetting your model. This now happens when initializing the model.
You can now also initialize attributes, which affect event generation, for example the availability, in
the Init Control. For this the init controls are now executed before the events are calculated. The
normal init methods, on the other hand, are executed after calculating the initial events.
Based on this enhancement the Init Control of the Transporter will now also be executed before the
events are calculated. In previous version the init control was executed after the events were
calculated.

• We changed the behavior of the Exit strategy > Carry part away. It is not allowed any more for
objects which are part of a balanced line. For models, which you created in previous versions, Plant
Simulation deactivates the object Cycle when you had activated Carry part away for one of the
objects it controls.

Changed Features of the Material Flow Objects
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• We changed the behavior of the AssemblyStation. When it has objects of type Store as predecessors,
it requests the required mounting parts from the Store. If the required parts are not available in the
Store at the moment, the Store records the request and delivers the parts to the AssemblyStation
when they are available again.
The parts can also be carried from the Store to the AssemblyStation by a Worker. The Store can only
provide mounting parts, but no main parts and has to be connected with a Connector, even when the
Worker carries the part away.

• We changed the behavior of the method mu of the Container, the Transporter with a loading space,
and of the Store. You can now call it with the parameter -1. Then the method returns the last MU on
the object or VOID when the object is empty. You can, for example, use the method to unload a
Container in reverse order.

• We changed the behavior of Plant Simulation. The method finishedTime of the MUs is now
observable.

• We changed the behavior Plant Simulation. The attribute RemainingSetupTime is now observable.

• We do not support the method createObject any more. Use the methods derive or duplicate instead.
To create the object at a certain position in the Frame, use the attribute Coordinate3D.

• We do not support the method ShowStandardMenus any more.

Back to What’s New in Tecnomatix Plant Simulation 14

New and Changed Features of the Fluid Objects

Tecnomatix Plant Simulation 14 provides a number of new and improved features.

New Features in Plant Simulation 13.2

We added the observable attribute currentMaterial to the Portioner.

New and Changed Features in Plant Simulation 13.1

• We added the Tab Controls and the Ingredient complete control to the Mixer.

• We replaced the method setUp with the method resSetUp.

Back to What’s New in Tecnomatix Plant Simulation 14

New and Changed Features of the Resource Objects

Tecnomatix Plant Simulation 14 provides a number of new and improved features.
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New and Changed Features in Plant Simulation 14.0

We added an optional parameter to the method getRouteLength which sets if the Worker gets to the
Workplace by walking freely within the area or not

New and Changed Features in Plant Simulation 13.1

We changed the behavior of the Workplace when you create a new model. Now Worker stays here
after completing the job is activated by default.

Back to What’s New in Tecnomatix Plant Simulation 14

New Features of the Information Flow Objects

Tecnomatix Plant Simulation 14 provides a number of new features.

New Features in Plant Simulation 14.0

• We added the method deleteContent to the TableFile.

• We added a message when you try to change the source code of a read-only Method.

• We added an optional parameter to the method open of the FileInterface.

• We added an optional parameter to the method open of the SQLite Interface.

New Features in Plant Simulation 13.2

• We added the PLCSIM Interface.

• We added the feature Statements to the SQLite Interface.

• We added the method executeStatement to the SQLite Interface.

• We added a feature allowing you to set a class breakpoint and/or an instance breakpoint for an
encrypted method. The Method then stops at, respectively during, method execution in the
Debugger.
When you did set a breakpoint, this Method shows the breakpoint with the respective icon within the
Method editor or the Method debugger before the message Source code is encrypted.

New Features in Plant Simulation 13.1

• We added the OPCUA Interface.

• We added the PLCSIM Interface.

New Features of the Information Flow Objects
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• We added a function which shows the elapsed time in the status bar of the Method Debugger when
you execute one or several instructions in a Method with the commands Step Over (F10), Step Into
(F11), Step Out (Shift+F11) or Run to Cursor (Shift+F10) and when executing the instructions takes
10 milliseconds or longer.

• We added the tab Anonymous Identifiers to the watch window of the Method. Plant Simulation
now shows the anonymous identifiers @ and ? on this tab instead of the Tab Variables as in previous
versions of the program.

• We now mark temporary breakpoints and bookmarks in the source code of a Method in a brighter
color than saved breakpoints and bookmarks. This might, for example, be the case when you changed
the source code of a Method and set a breakpoint or a bookmark after the original end of the source
code. These breakpoints or bookmarks are lost when you do not apply the source code.

• We added the method getHTMLCode to lists and tables.

• We added the method copyContentTo to the lists and tables.

Back to What’s New in Tecnomatix Plant Simulation 14

Changed Features of the Information Flow Objects

Tecnomatix Plant Simulation 14 provides a number of changed features.

Changed Features in Plant Simulation 14.0

• We changed the behavior of the column width of lists and tables. It is now limited to 180.

• We removed support for the method selectSyncFromDialog of the Teamcenter Interface.

Changed Features in Plant Simulation 13.2

• We fixed non-expected behavior that occurred in the method find of lists and tables. When you
searched a table and then started a second search, for which you entered a range, which did not
contain the cell of the first search, the search was only started after the first cell of the new range, as
the search was continued.
Now we reset the search and the search then starts in the first cell of the range as if a call of the
method setCursor had been executed.

• We added the columns Description and Creation Date to the tables in the dialog Select Teamcenter
Sync (Import). In addition, you can now sort the columns in the tables.

• We changed the names of the following interface objects:

1. What's New
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Old Name New Name

OPCUAInterface OPCUA

OPCClassicInterface OPCClassic

SIMITInterface SIMIT

Changed Features in Plant Simulation 13.1

• We renamed the OPCInterface to OPCClassicInterface and we added the OPCUAInterface.

• We activated the setting Decimal places for the Variable for variables of data type time.

• We replaced the methods indexXDim and indexYDim of the TableFile with the read-only attributes
XDimIndex and YDimIndex.

• We changed how Plant Simulation exports data from tables with the command Export Excel File to
the Excel format: Until now Plant Simulation always used the proprietary SI units and not the unit that
you had selected. Now Plant Simulation exports the data with the settings that you selected for the
units. Suppose that you selected Foot as the length unit for a column of data type Length. Then Plant
Simulation exports the values in Feet to Excel and interprets the values as Feet when you import
them back to Plant Simulation.

• We added an optional parameter to the method openDialogBox. You can use it to set that the
column widths will be calculated automatically.

• We do not support the attributes ShowToolbar and ShowStandardMenus any more.

Back to What’s New in Tecnomatix Plant Simulation 14

New and Changed Features of the User Interface Objects

Tecnomatix Plant Simulation 14 provides a number of new and improved features.

New and Changed Features in Plant Simulation 14.0

• We added the object WorkerSankeyDiagram to the User Interface objects.

• We added a message that asks if you want to cancel your changes when you click Cancel or press the
Esc key in the dialog of the object HtmlReport.

New and Changed Features in Plant Simulation 13.2

• We added access to cells of lists and tables in the object HtmlReport.

• We changed the syntax of the method getHtmlCode of the Chart.

New and Changed Features of the User Interface Objects
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New and Changed Features in Plant Simulation 13.1

• We added the method setEditType to the object Dialog.

• We enhanced the functionality of the object HtmlReport. You can set the table columns for objects
which show statistics tables in the report, compare Display Statistics Values of an Object as a table
in the Report.

• We changed the unit with which Plant Simulation shows the width and the height of the objects
DropDownList and Button. In previous versions these were displayed in pixels, now they are shown in
meters.
To facilitate this, we introduced the attributes ObjectWidth and ObjectHeight and we removed
support for the attributes Width and Height.

• We moved the setting Data in the dialog of the object Chart from the tab Display to the Tab Data.
The setting Display in Frame on the tab Display now also affects 3D.
When Display in Frame is activated, you can now enter the Width and the Height of the chart in
length units, for example in meters. You can also set the dimensions with the attribute SizeInFrame.

• We replaced the methods getValue and setValue of the object Display with the attribute Value.

Back to What’s New in Tecnomatix Plant Simulation 14

New and Changed SimTalk Features

Tecnomatix Plant Simulation 14 provides a number of new and improved features.

New and Changed Features in Plant Simulation 14.0

• We added the keyword waitExpired. This way you can specify a time limit for waituntil- and
stopuntil-statements.

• We made these changes in connection with the internal web server of Plant Simulation:

• The internal web server will now only be started when you entered the start option -WebServer
or -WebServer:Portnumber.

• The function portNumber now returns 0 when the web server has not been started.

• For the function openHTMLBrowser URLs that begin with L/ only work when the web server has
been started.

New and Changed Features in Plant Simulation 13.2

• We added the method appendArray to the arrays.
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• We changed the behavior of the wait instruction: When it is executed with a negative time, Plant
Simulation opens the Method Debugger and shows an error message. In previous versions a negative
wait time was implicitly changed to 0.

• We added the method _3D.activateMaterialWithColor for the MUs.

New and Changed Features in Plant Simulation 13.1

• We enhanced the functionality of the modulo operator, compare Arithmetic Operators. They now
also work for floating point values.

• We enhanced the functionality of the arrays. You can now add and subtract arrays of numerical
data types.

• We added the function getErrorStop.

• We enhanced the fuctionality of SimTalk 2.0. You can now enter time literals:

wait 1:30  -- wait 1 Minute and 30 seconds
&Method.methCall(1:0:0:0.5) -- call the Method in 1 and half a second

• We changed the behavior of Plant Simulation. When the SimTalk functions for arrays min and max
are called with two values, which have the same physical unit, the return value now also has this
value. Compare these examples

min(time, time)        -> time
min(length, length)    -> length
min(length, speed)     -> real
min(length, real)      -> real
min(integer, integer)  -> integer
min(integer, real)     -> integer
min(real, integer)     -> integer
min(integer, weight)   -> real

• We changed which objects the method numOfLimitedObjects does not count as well, namely
objects of type Interface and EventController.

Back to What’s New in Tecnomatix Plant Simulation 14

New 3D Features

Tecnomatix Plant Simulation 14 provides a number of new features.

New 3D Features
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New Features in Plant Simulation 14.0

• We added settings for the animation area to the tab MU Animation of the objects with matrix
loading space. The animation area replaces the function Create Paths > Create Locations of previous
versions of Plant Simulation.

• We replaced the setting Auto graphics active for the MUs with the setting Scale automatically. It
adjusts the size and the position of the graphic of the MUs to the dimension and the booking point of
the MU in 2D.

• We added settings for mirroring to the tab Transformation.

• We added settings for the rotation to the tab point cloud. This allows you to set a rotation with a
rotation angle and a rotation axis. In previous versions you could only set the rotation angle and the
point cloud used the pre-defined axis (0,0,-1).

• We added the command Insert Factory Walls.

• We added the setting Obstacle for the worker > Sides to the command Insert Stairs.

• We added the button Obstacles to the tab View of the 3D window.

• We added the button Adjust Graphics to MU Size to the tab Graphics of the MUs in the dialog Edit
3D Properties.

• We replaced the command Create Cone with the command Create Cone Frustum.

• We added buttons for moving camera marks up or down in the list of camera marks.

New Features in Plant Simulation 13.2

• We added the attributes _3D.ShowConnections, _3D.ShowExternalGraphics, _3D.ShowGrid,
_3D.ShowPointClouds, and _3D.ShowShadows.

• We added the attribute _3D.getPositionOfObject.

• We added the methods _3D.SelfAnimations.Animation.play, _3D.SelfAnimations.playRotation,
and _3D.SelfAnimations.playTranslation.

• We added the tab Captions to the dialog Edit 3D Properties of the objects.

• We added the command Show Statistics Report to the context menu of the animatable objects in
3D.

• We added the command Help on Dialog to the dialog Edit 3D Properties. It opens the help topic for
the dialog. You can then navigate to the help for the different tabs that the dialog provides.
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• We added alternative graphics for Euro pallets of type EUR 2/ISO2, EUR 3, and EUR 6/ISO0 to the Plant
Simulation installation folder > s3d-graphics > Containers. We use the Euro pallet of type EUR 1/
ISO1 as the standard graphic.

• We added a message that Plant Simulation shows when you exchange the 3D graphic of an object
with matrix loading space, such as the ParallelStation, the Container, the Workerpool, etc. Plant
Simulation now asks if you want to use the number of places from the 3D MU Animations of the new
graphic as the new capacity. This applies when the number of loading spaces differs between the
original graphic and the new graphic.

New Features in Plant Simulation 13.1

• We added the tab Robot Arm Animation to the dialog Edit 3D Properties of the PickAndPlace Robot.
On it you can set if it will be animated with one, three, or with four axes.

• We added the objects Dropdownlist, CheckBox, and Button to the objects which 3D shows. When you
set scaling on the tab Transformation in the dialog Edit 3D Properties, this does not affect the width
and the height in the dialog of the object in 2D. 3D only distorts the graphic of the object and does
not change its dimensions.

• We added the edddison interface.

• We added the sub-command Export Bitmap to the command Export Scene.

• We added the setting Optimize for to the command Insert Rack.

• We added the setting Show sensors to the dialog Edit 3D Properties > Tab Graphics.

• We added the command Show Corner Points to the context menu of the Connector. You can use it to
attach the Connector to another object.

• We added SolidEdge files (*.asm, *.par, *.psm) to the data types that Plant Simulation can import
as graphics.

• We added the method _3D.exportAsBitmap. It exports the designated 3D scene as a .PNG file.

• We added the methods _3D.addObject and _3D.delete.

• We added the method _3D.SelfAnimations.scheduleTranslation.

Back to What’s New in Tecnomatix Plant Simulation 14

Changed 3D Features

Tecnomatix Plant Simulation 14 provides a number of changed features.

Changed 3D Features
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Changed Features in Plant Simulation 14.0

• We changed how to create rotation paths. You can now select the setting Rotation path (Lines)
instead of clicking the button Create Paths > Create Rotation Path.

• We changed the functions of the command Insert Cylinder. You can now select the individual parts
of the cylinder that you want to create.

• We changed how 3D searches for applicable MU animation paths for showing Workers. This no longer
works based on animation path names, for example Default for the FootPath or #0#1, etc. for the
WorkerPool, but based on the consecutive number in the MU animation attribute as already
implemented for MUs on the PickAndPlace robot or on a Worker. When 3D does not find the path with
the required number, for example the second path to show the second Worker on the WorkerPool, it
uses the path named Default if that path exists.

• We removed the commands Show/Hide Camera Icons and Toggle Camera from the tab View of the
3D window.

• We separated inheritance of the state graphics from inheritance of the object graphics on the tab
Graphics. You can now activate or deactivate them separately with the toggle buttons next to Object
graphics and State group.

• We changed the behavior when modifying the orientation of a State group. The last transformation
of the vertical or horizontal state group now does not get lost any more.

• We changed how 3D scales. In previous versions you could also enter a negative scaling factor. From
version 14 on we split this into settings for unsigned scaling (settings for scaling) and settings for
mirroring.

• We changed how the WorkerPool in 3D looks. It now looks like this:

As opposed to 2D it only shows a single Worker in 3D. If you would like to see how many Workers are
staying in the WorkerPool, open it in a new 3D window.
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• We changed how the command Lock Structure works. It now also prevents you from inserting
graphics.

• We changed the data type of the 3D attributes and the parameters of 3D methods, which refer to a
position or to dimensions. In previous versions the data type was real. From this version on the data
type is length or an array of data type length.

• We changed the behavior for the first anchor point of an extrusion polycurve. For the first anchor
point you cannot open the dialog Edit 3D Properties.

• We changed the behavior when selecting something in a 3D window. From this version on this
selection is only visible in this 3D window except the selection is an MU instance.
In previous versions this selection was visible in all open 3D windows. If, for example, you selected a
graphic in an open Station, this graphic was marked as selected in all 3D windows for all Stations
which inherit their graphics from this Station or from the Station from which this graphic inherits.
When you selected an object this object was shown as selected in all windows, for example in an
inserted Frame instance as well as in the Frame class and in all windows which were opened for that
object. Now this is only the case when you select an MU instance, namely the object and not its
graphic.

• We activated the buttons for controlling the simulation on the mini toolbar in the 3D window of an
animatable object.

• In Full Screen mode you can now also show the frame rate by pressing the F key and use the
multimedia buttons on multimedia keyboards.

• We changed the behavior when rolling the mouse wheel in the window of a 3D scene. Plant
Simulation now zooms the 3D scene in when rolling the mouse wheel forward. In previous versions it
zoomed the scene out. To facilitate this, we changed the standard setting under Preferences > 3D >
Mouse wheel behavior to Move camera. In previous versions it was Move scene. The new standard
setting is the same as in NX and on Web sites.

• We added a second optional parameter to the method _3D.exchangeGraphic.

Changed 3D Features
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Changed Features in Plant Simulation 13.2

• We enhanced the behavior of 3D. You can now combine the functions Align to Grid and Snap to
Grid.

• We enhanced the behavior of the function Align to Grid. It now also applies to graphics.

• We changed the behavior of the feature Show Shadows. You can now only activate it for objects of
type Frame.

• We changed the behavior of the extrusion configuration of the length-oriented objects on the tab
Appearance in the dialog Edit 3D Properties. We renamed the conveyor type setting Not defined to
User-defined.
We moved the settings for defining a user-defined conveyor from a series of sub-dialogs to the tab
Appearance itself.
We limited the values for graphic group IDs in the extrusion configuration to values between 0 and
10.

• We renamed the following methods: _3D.pauseAnimation to _3D.pause, _3D.playAnimation to
_3D.play, and _3D.resetAnimation to _3D.reset.

• We removed the button Show Preview from the dialog Edit 3D Properties. The program now shows
changed values immediately after changing them.

Changed Features in Plant Simulation 13.1

• We renamed the tab Extrusion for length-oriented objects in 3D to Tab Appearance.

• We enhanced the behavior of 3D for displaying objects of type Display, Comment, and Variable in 3D
windows. 3D now shows them with the font size that you selected in the dialog of the object in 2D.

• We enhanced the behavior of 3D for displaying angle-dependent Connectors. They are now displayed
as in 2D, namely depending on the angle between the objects.

• We changed the coordinates with which we define the bounding box of an obstacle for the Worker:

• From this version on we use the object coordinates. Previous versions used the coordinates of the
graphic nodes.

• The bounding box of the methods _3D.BoundingBoxSize, _3D.BoundingBoxMax,
_3D.BoundingBoxMin, and _3D.BoundingBoxCenter as well as some interactive functions now
excludes all hidden graphics.

• We changed the behavior when calculating the bounding box of the objects in 3D: Displayed path
nodes and objects, which are located on the object, are now excluded from the calculation.

• We changed what the command Export Graphics exports:
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• If you selected an object or a graphic in the active 3D window, 3D exports the selected object or the
selected graphic.

• If you did not select anything, 3D exports all graphics that are visible in the 3D window.

• We changed the behavior when Plant Simulation automatically inserts Connectors. 3D now uses the
Interface, when you insert an Interface into 3D Frames with visible contents and move it with the
mouse or with keyboard keys.

• We renamed the command Insert Facet to Insert Plate.

• We added four additional settings to the function MU side to attach and we changed the functioning
of the existing settings.

Back to What’s New in Tecnomatix Plant Simulation 14

Miscellany

Tecnomatix Plant Simulation 14 provides a number of new and improved features.

New and Changed Features in Plant Simulation 14.0

• We do not start the internal webserver automatically any more. If you want to use it, you have to start
it explicitly with the start option /WebServer.

• We do not show the TransferStation by default on the tab Tools any more when creating a new
model. You can always add it to your model via Start > Manage Class Library. The new functions of
the pick-and-place robot can now also emulate most of the functions of the TransferStation.

• We moved the settings for Connectors, namely Connect objects automatically and Connector
positioning from the tab User Interface to the tab General in the dialog Preferences.

• We added the settings for Connectors to the tab General in the dialog Model Settings.

• We matched the categorization of the attributes and methods in the Online Help in the Online Help
with the categories in the dialog Show Attributes and Methods in Plant Simulation itself. We now
list the Methods of the Material Flow Objects, the Read-Only Attributes of the Material Flow
Objects, and the Attributes of the Material Flow Objects.

New and Changed Features in Plant Simulation 13.2

• We matched the description of the syntax of Methods and Attributes in the Online Help with the
signature in the dialog Show Attributes and Methods in Plant Simulation.

• We matched the categorization of the attributes and methods in the Online Help in the Online Help
with the categories in the dialog Show Attributes and Methods in Plant Simulation itself. We now

Miscellany
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list the Methods of the Material Flow Objects, the Read-Only Attributes of the Material Flow
Objects, and the Attributes of the Material Flow Objects.

• We changed the selection that Plant Simulation offers when creating a new simulation model. Plant
Simulation now only asks if you want to create 2D model or a 3D model. The setting 2D and 3D is not
required any more as you can activate 3D any time for an existing 2D model by clicking Activate 3D
on the tab Windows of the ribbon bar.

Previous Versions From Version 13.2 on

• We changed how Plant Simulation shows a user-defined ribbon tab. In previous versions Plant
Simulation showed it under the ribbon tab/category Frame or 3D. Now Plant Simulation shows it as a
ribbon tab/category of its own named User.

Previous Versions From Version 13.2 on

• We renamed the tab Modeling to 2D. This allows us to hide the tab 2D when you are only working
with a 3D model.

• We moved the Connector settings Connect objects automatically and Connector positioning from
the tab 2D to the tab User Interface in the Preferences dialog.
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• We changed the behavior of the View Options, such as Show Object Names, in the Frame. When
you change one of these settings Plant Simulation changes it in the class from which this setting is
inherited. If you only want to change the setting in the local instance, you have to deactivate
inheritance first. We changed this because, as a rule, you will want to change the setting for all
instances of the Frame.

• We added the check box Requires 3D to the dialog Edit Library Information. When you load a library
for which this setting is selected, and when 3D is not activated, you will be asked if you would like to
activate 3D. When you click No, the library will not be loaded.

• We moved the command Edit 3D Properties in the context menu of the selected object in the Class
Library up to the commands for opening the object.

• We added an error message that Plant Simulation shows when you created a new object with the
command Derive and when the new name, that you entered, could not be assigned.

• We enhanced the visualization of the BottleneckAnalyzer in 3D. We replaced the transparent box
with transparent sides with lid and we adjusted the width to the number of columns.

New and Changed Features in Plant Simulation 13.1

• We renamed the settings under Model Settings > General > Visualization. We added the setting Ask
Each Time to Preferences > General > Visualization.

• We added the folder User Objects to the Class Library and to the Toolbox. Create and store the
objects, which you yourself develop, in this folder.

• We added the folder Objects to the folder into which Plant Simulation is installed. By default it
contains sub-folders with object files for Containers and Transporters. You can also save object files
for re-usable objects which you and your colleagues created.

• We added the button Update All Libraries to the dialog Manage Class Library. You can use it to
update all libraries to the newest version.

• We changed the behavior of when selecting objects in the Toolbox: When you select an object in the
Toolbox while holding down the Ctrl key, the object remains selected in the Toolbox after inserting it.
Thus you can insert several instances of the selected object one after the other. You can terminate
this mode with the right mouse button or with the Esc key.

Back to What’s New in Tecnomatix Plant Simulation 14
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What's New in the Object Libraries

New and Changed Features of the Object Libraries

The object libraries in Tecnomatix Plant Simulation 16 provide a number of new and enhanced
functions.

• New and Changed Features of the Object Libraries in Plant Simulation 16

• New and Changed Features of the Object Libraries in Plant Simulation 15

• New and Changed Features of the Object Libraries in Plant Simulation 14

Back to What’s New

New and Changed Features of the Object Libraries in Plant Simulation 16

The object libraries in Plant Simulation 16 provide a number of new and enhanced functions.

New Features and Changed Features in Plant Simulation 16.0

We made the following changes and enhancements to the Value Stream Mapping library.

• We undertook a number of extended restructuring measures in the background of the objects of the
Value Stream Mapping library.

• We changed the definition of the setup matrixes. For better reproducibility these now refer to the
station-final final products instead of to the base products as in previous versions.

• We changed the behavior of the Supermarket. It does not accept over-ordering any longer as the
maximum stock now also is physically limiting.

• We changed the behavior of Value Stream Mapping objects with missing connections. The model
Frame cannot contain such objects any more. The object Check shows a corresponding message.

• We changed how order queues are updated. These are now updated every five minutes and they
reflect the time-weighted average.

• We extended the behavior of process to process linkages. These are now allowed. It is no longer
required to insert the objects FIFO and InternalTransport between two Process objects.

• We improved the local order management in Processes and we unified, among others, the BOM
definitions.
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• We improved how materials are passed on. Each object now has an entrance store from which,
starting with base parts, the station-final parts are created, analog to the assembly. In previous
versions parts were sometimes buffered and then deleted.

• We fixed bugs in the disposition routine which sometimes occurred for certain constellations in
several used base parts, including assemblies.

• We undertook capsuled combinations in sub-Frames at a number of places. We also renamed internal
statistics and data structures. This is important if you explicitly accessed them to return values via
SimTalk.

New Features and Changed Features in Plant Simulation 15.2

• We added the tool Gozintograph to the Value Stream Mapping library.

• We changed the behavior of the GAWizard. The predefined value of the user-defined Attribute
lastGeneration4DuplicatesCheck now is -1. The GAWizard then runs a check for all generations on the
already evaluated individuals. You can change the value of the attribute
lastGeneration4DuplicatesCheck. You can enter -1 and positive integer numbers.

• We changed the behavior of the SequentialSampler with several simulation runs. You can now set the
number of observations so that the confidence interval for a given target value has the desired width.
You can still use the Batch method that previous versions provided.

New Features and Changed Features in Plant Simulation 15.1

We fixed a bug of the ExperimentManager which occurred when an input value or an output value was
set by an absolute path and the ExperimentManager was not located in the root Frame.

Back to New and Changed Features of the Object Libraries

New and Changed Features of the Object Libraries in Plant Simulation 15

The object libraries in Plant Simulation 15 provide a number of new and enhanced functions.

New Features and Changed Features in Plant Simulation 15.0

• We enhanced the behavior of the ExperimentManager. For each output value, which is not an object
of type DataTable, you can select in the table Output Values in the column High values are better if
higher values are better or not. The ExperimentManager creates the parametrization (sets of input
values) for the desired output values, which have the best output value (as mean value) and shows
them under the heading Best Parametrizations of the Model of the HtmlReport.
For each output value you can show all parametrizations of the model which result in a maximum or
minimum mean value respectively with the method getBestParameter.
The ExperimentManager can now show Sankey diagrams in a non-distributed simulation in the
HtmlReport.

New and Changed Features of the Object Libraries in Plant Simulation 15
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When some observations of output values are not available in a distributed simulation because of
terminated simulation runs, the statistics values, for example the mean value, are now only computed
for the correctly simulated observations.

• We added the tool Timeline to the Value Stream Mapping library.

• We added the attributs simulateWithAnimation and DCOM_StartDelay to the ExperimentManager
and to the GAWizard, compare Executing Distributed Simulations.

• We added the check box Apply settings to connected rack lanes to the RackLane of the High Bay
Warehouse.

Back to New and Changed Features of the Object Libraries

New Features and Changed Features in Plant Simulation 14.2

• We removed the localization of the libraries CranesAndMore, CrossSlidingCar, and HBW. These only
provide these libraries with an English user interface from now on.

• We changed the functions that the tab 3D of the GantryLoader provides.

• We moved the library CrossSlidingCar from the Tools to the library CranesAndMore.

• We added the object Lift to the library CranesAndMore

• We renamed the method moveMUFromTo of the portal of the MultiPortalCrane to transferMU.

Back to New and Changed Features of the Object Libraries

New Features and Changed Features in Plant Simulation 14.1

• You can delete the folder for the distributed simulation if the ExperimentManager and the GAWizard
are of version 14.1 or higher.

• The user-defined methods of the ExperimentManager for configuring, for setting the input values of
the random number streams, and for the evaluation now have to be realized as objects of type
Method. The configuration method and the method for calculating the fitness of the GAWizard are
also realized like this. This way the controls of the material flow objects and these configuration
methods behave the same. As these user-defined methods of these two Tools were realized with
Methods in previous versions, which were loaded in the Frames of these Tools, you have to save the
source code of these methods in new Method objects.

• Note that the source codes of these user-defined methods have a different name space. The method
for evaluating the ExperimentManager is only called at the end of an experiment study in version
14.1 and thus has only a single parameter for the calling ExperimentManager. In this method you
can, for example, transmit statistical evaluations of the table DetailedResults of the
ExperimentManager to another application.
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• We removed the StorageCrane from the library Cranes as we do not support the StorageCrane any
more. The objects MultiPortalCrane and StorageArea replace it.

Back to New and Changed Features of the Object Libraries

New and Changed Features of the Object Libraries in Plant Simulation 14

The object libraries in Plant Simulation 14.0 provide a number of new and enhanced functions.

• We added the GantryLoader to the CranesAndMore library.

• We adjusted the position and the dimension of the racks and the conveyors in the High Bay
Warehouse (HBW) library so that no gaps appear when you insert them into your model.

• We enhanced the functions of the object Warehouse Management System (WMS) in the High Bay
Warehouse (HBW) library.

Back to New and Changed Features of the Object Libraries

New and Changed Features of the Object Libraries in Plant Simulation 14
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